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iv. Pro Tools Software Installation Guide



Installing Pro Tools Software

Welcome to Pro Tools® from Avid. This guide documents how to install and authorize Pro Tools
on Mac and Windows systems. For detailed information on configuring your Pro Tools system,
and for complete information about Pro Tools system capabilities and functionality, see the
Pro Tools Reference Guide (available from the Help menu in Pro Tools).

There are four types of Pro Tools systems:
Pro Tools Software

These systems include Pro Tools software with Avid 003™ or Digi 0022 family audio interfaces,
Eleven® Rack, Mbox® or Mbox 2 family audio interfaces, or M-Audio hardware. These systems
also include Pro Tools software using third-party audio interfaces with supported Core Audio
(Mac, including the built-in audio on Mac computers) or ASIO (Windows) drivers.

Pro Tools HD Software with Hardware Acceleration

Hardware-accelerated Pro Tools HD systems include Pro Tools HD software with Avid HDX,
Pro Tools|HD, or HD Native hardware. Hardware-accelerated systems provide expanded I/0
capabilities and low latency monitoring. Pro Tools HD software with Avid HDX or Pro Tools|HD
hardware also provides dedicated DSP for plug-in processing and for large mixer configurations.
Pro Tools HD Software or Pro Tools Software with Complete Production Toolkit

These systems include Pro Tools HD software or Pro Tools software with the Complete Production
Toolkit option with any compatible Avid, Core Audio, or ASIO hardware.

Pro Tools Express Software

These systems include Pro Tools Express software with Mbox family audio interfaces (3rd
generation). (For more information, see the Pro Tools Express Install Guide.)

\Q/ For a list of qualified audio interfaces and computers for all Pro Tools systems, visit

www.avid.com/compatibility.
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System Requirements and Compatibility

Pro Tools can be used with a qualified audio interface, running on a qualified Windows or Mac
computer.

A DVD drive is required to use the Pro Tools Installer disc.

An internet connection is required for downloading the Pro Tools Installer.

Avid can only assure compatibility and provide support for hardware and software it has tested
and approved.

For complete system requirements and a list of qualified computers, operating systems, hard
drives, and third-party devices, visit:

www.avid.com/compatibility

Authorized iLok

The standard Pro Tools software package includes a pre-authorized iLok for running Pro Tools
software. Hardware packages with Pro Tools include one unauthorized iLok and an Activation
code for your Pro Tools authorization. For more information, see “Authorizing Pro Tools” on

page 3.

A An authorized iLok must be inserted in an available USB port on your computer to run
Pro Tools.

MIDI Requirements

USB, FireWire, and PCI MIDI interfaces work effectively with Pro Tools systems on Mac or
Windows. Serial MIDI interfaces are supported on Windows systems only.

For a list of supported MIDI interfaces and controllers, visit www.avid.com.
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Hard Drive Requirements
For optimal audio recording and playback, all Pro Tools systems require one or more qualified
hard drives.

Initialize your hard drives with the Disk Utility application included with Apple System software
(Mac) or Windows Disk Management (Windows).

Avoid Recording to the System Drive
Recording to your system drive is allowed, but not recommended. Recording and playback on
a system drive may result in lower track counts and fewer plug-ins.
\Q’ For optimum performance, you may want to designate your system drive as a Playback or
= Transfer only volume in DigiBase. For more information, see the Pro Tools Reference Guide.

Authorizing Pro Tools

Pro Tools software is authorized using the iLok USB Smart Key (iLok) from PACE Anti-Piracy.
An iLok can hold hundreds of authorizations for all of your iLok-enabled software. Once an
iLok is authorized for a given piece of software, you can use the iLok to authorize that software
on any computer.

iLok USB key

“C) You can use either the new version of the iLok (shown above) or the previous version of
the iLok to hold your Pro Tools authorizations.
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Pro Tools HD Authorization

A Pro Tools HD authorization lets you run Pro Tools HD software on a supported Mac or Windows
computer with or without Avid HDX, Pro Tools|HD, or HD Native hardware. A Pro Tools HD
authorization also lets you run Pro Tools HD software with any other Avid-qualified audio
interface (such as Mbox Pro or Fast Track) or any third-party audio interface with supported
Core Audio (Mac) or ASIO (Windows) device drivers.

Pro Tools Authorization

A Pro Tools authorization lets you run Pro Tools software on a supported Mac or Windows
computer with an Avid-qualified audio interface (such as Mbox Pro or Fast Track) or any third-
party audio interface with supported Core Audio (Mac) or ASIO (Windows) device drivers.

A A Pro Tools authorization is insufficient to run Pro Tools HD software. Attempting to launch
Pro Tools software on a system with HDX, Pro Tools|HD, or HD Native hardware without
a Pro Tools HD authorization results in Pro Tools software launching if it can use Core
Audio or ASIO with the built-in sound or another audio interface, but it will not be able
to use any installed HDX, Pro Tools|HD, or HD Native hardware.

Complete Production Toolkit Authorization

A Complete Production Toolkit authorization along with a Pro Tools authorization lets you
run Pro Tools software with Complete Production Toolkit functionality. Complete Production
Toolkit software option for Pro Tools provides increased voice and track counts, and surround
mixing, editing, and automation capabilities that are equal to Pro Tools HD

For more information about Complete Production Toolkit, see the Complete Production
Toolkit Guide or the Pro Tools Reference Guide.
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Authorizing iLok with an Activation Code

If you purchased a new boxed version of Pro Tools software, it comes with a pre-authorized
iLok. You can skip this section and proceed with “Installing Pro Tools” on page 6.

If you purchased a new Avid HDX, Pro Tools|HD, or HD Native system, it comes with an empty
iLok and an Activation Code (on the included Activation Card) for authorizing Pro Tools HD
software. Follow the authorization instructions below.

If you upgraded from an earlier version of Pro Tools software, it comes with an Activation Code
(on the included Activation Card) for authorizing your software upgrade on your iLok. Follow
the authorization instructions below.

To authorize Pro Tools software using an Activation Code:
11If you do not have an iLok.com account, visit www.iLok.com and sign up for an account.
2 Transfer the license for your software to your iLok.com account by doing the following:
« Visit www.avid.com/activationcard.
-and -

« Input your Activation Code (listed on your Activation Card) and your iLok.com User ID.
Your iLok.com User ID is the name you create for your iLok.com account.

3 Transfer the licenses from your iLok.com account to your iLok USB Smart Key by doing the
following:

« Insert the iLok into an available USB port on your computer.
« Go to www.iLok.com and log in.

« Follow the on-screen instructions for transferring your licenses to your iLok.

For more information, visit the iLok website (www.iLok.com).
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Installing Pro Tools

A If you are upgrading Pro Tools, be sure to uninstall any lower version of Pro Tools from
your computer. See “Uninstalling Pro Tools” on page 14.

Installation Overview

Installation of Pro Tools includes the following steps:

1 “Installing Hardware Drivers” on page 6.

2 “Installing Pro Tools Software” on page 7.

3 “Installing Avid Virtual Instruments” on page 10 (optional).

4 “Launching Pro Tools” on page 12.

5 Configuring your system for improved performance (see the Pro Tools Reference Guide).

6 Making audio connections to your audio interface. (Refer to the documentation that came
with your audio interface.)

Installing Hardware Drivers

Before installing Pro Tools software, ensure that you have installed your audio hardware and
that you have installed the latest drivers for your hardware. Refer to the documentation that
came with your hardware for more information. For Avid audio interfaces, install the drivers
for your hardware using the corresponding driver installer on the Driver Installers disc included
with the Pro Tools Installer package, or visit www.avid.com/drivers to download and install
the latest drivers for your device.
" For Avid HDX, Pro Tools|HD, and HD Native hardware only, the Pro Tools installer in-
stalls the necessary hardware drivers automatically.

A Pro Tools will not recognize your audio interface if you do not install the drivers. If you
are upgrading Pro Tools, be sure to install the latest drivers for your hardware.
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Installing Pro Tools Software

After you have installed the drivers for your audio interface, you are ready to install Pro Tools.
A Before installing this version of Pro Tools, refer to the included Read Me information.

To install Pro Tools:

1 Make sure you are logged in as an Administrator for the account where you want to install
Pro Tools.

2 Do one of the following:
« Insert the Pro Tools Installer disc in your DVD drive.
—or-
« Download the Pro Tools installer online.
3 Do one of the following:
o On Mac, locate and double-click Install Pro Tools.mpkg.
« On Windows, do one of the following:
« If Windows AutoRun is enabled, a mini-browser appears. Select Install Pro Tools to begin
installation.
_or-
o If Windows AutoRun is disabled, locate and double-click Setup.exe, and then select Install
Pro Tools to begin installation.

A On Windows, if the User Account Control dialog appears, click Allow. Several messages
are displayed during installation that can be ignored, including multiple “Found New
Hardware” dialogs and “A Problem Occurred During Hardware Installation.” Additionally,
if you get a warning dialog about the driver not passing Windows Logo testing, click
Continue Anyway.
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4 Follow the on-screen instructions to continue with installation.

5 At the Installation Type page, do one of the following:

To install all Pro Tools application files and free plug-in suites (and associated content), leave
the default Installation options selected and click Continue.

- or -

.

Select (or deselect) a custom configuration of Installation options (see “Installation Options”
on page 8) and click Continue.

6 Click Install.
7 If prompted, enter your Administrator password and click OK to authenticate the installation.
8 Follow the remaining on-screen instructions.

9 When installation is complete, click Restart (Mac) or Finish (Windows).

\Q’ The Pro Tools Installer disc includes additional software for your system. For more information,
©  see “Additional Software on the Pro Tools Installer Disc” on page 13.

Installation Options
Pro Tools 10 Options

To install a subset of Pro Tools software and plug-ins, click the reveal triangle for the Pro Tools
10 option in the installer, and deselect any of the following options that you do not want installed.
Application Files (Required for Pro Tools). Installs the Pro Tools application and supporting library
files needed to run Pro Tools. This option must be selected to install Pro Tools.

Avid Effects. Installs free Avid Audio Effects plug-ins. For more information, see the Audio
Plug-ins Guide.

Pro Tools Utilities. Installs Pro Tools utilities, such as DigiTest and Uninstall Pro Tools (Mac only).
Additional Options.

The Pro Tools installer provides the following additional options to install along with Pro Tools
software and plug-ins.
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Mac HFS+ Disk Support Option (Windows Only). This option lets your Pro Tools system read, write,
record, and play back using Mac-formatted HFS+ disks. HFS+ disks are commonly referred
to as Mac OS Extended disks. For more information, see the Pro Tools Reference Guide.

Avid Video Engine. The Avid Video Engine is required to use Pro Tools with Avid video peripherals
such as the Avid Mojo® SDI. For more information, see the Avid Video Peripherals Guide.

Starting Up or Shutting Down Your System

To ensure that the components of your Pro Tools system communicate properly with each other,
you need to start them in a particular order.

Start up your Pro Tools system in this order:

1 Make sure all your equipment (including your computer) is off.

2 Lower the volume of all output devices in your system.

3 For systems with an expansion chassis, turn on the chassis.

4 Turn on any external hard drives. Wait ten seconds for them to spin up to speed.
5Turn on any control surfaces.

6 Turn on any MIDI interfaces and devices, or synchronization peripherals.

7 For systems requiring external power, then turn on the hardware (such as HD 1/0 or 003).
Wait at least fifteen seconds for the audio interface to initialize and the status LEDs to stop
flashing.

8 Turn on your computer.

9 Launch Pro Tools (see “Launching Pro Tools” on page 12) or any third-party audio or MIDI
applications.

Installing Pro Tools Software 9



Shut down your Pro Tools system in this order:

1 Quit Pro Tools and any other running applications.
To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).

2 Turn off or lower the volume of all output devices in your system.

3 Turn off your computer.

4 For systems that use hardware requiring external power, turn off the hardware.
5 Turn off your Pro Tools audio interfaces.

6 For systems with an expansion chassis, turn off the chassis.

7 Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.

8 Turn off any control surfaces or worksurfaces.

9 Turn off any external hard drives.

Installing Avid Virtual Instruments

Avid provides a suite of free virtual instrument plug-ins with related sample content for use
with Pro Tools. For more information, see the Audio Plug-ins Guide.
To install Avid Virtual Instruments:

1 Make sure you are logged in as an Administrator for the account where you want to install
Avid Virtual Instruments.

2 Do one of the following:
« Insert the Pro Tools Installer disc in your DVD drive.
_or -

« Download the Avid Virtual Instruments installer and related content online.

10 Installing Pro Tools Software



3 Do one of the following:
« On Mac, locate and double-click Install Avid Virtual Instruments.mpkg.
« On Windows, do one of the following:
« When installing from disc, if Windows AutoRun is enabled, a mini-browser appears. Select

Install Avid Virtual Instruments to begin installation.

When installing from disc, if Windows AutoRun is disabled, locate and double-click Setup.exe,
and then select Install Avid Virtual Instruments to begin installation.

« If you downloaded the Avid Virtual Instruments installer, run Avid Virtual Instruments.exe.
4 Follow the on-screen instructions to continue with installation.

5 Click Install.

A Virtual Instrument content is very large and may take up to 20 minutes to install. During
this time, the progress bar may not appear to move but your software is still installing. Do
not terminate your installation.

6 If prompted, enter your Administrator password and click OK to authenticate the installation.
7 Follow the remaining on-screen instructions.

8 When installation is complete, click Close (Mac) or Finish (Windows).
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Launching Pro Tools

To use Pro Tools software, you must have an iLok with a license authorizing the version of
Pro Tools that you have installed (for more information, see “Authorizing Pro Tools” on page 3).

To launch Pro Tools software:
1 Make sure your audio interface is connected to your computer and powered on.

2 Insert an authorized iLok into any available USB port on your computer (see “Authorizing
Pro Tools” on page 3).

A Do not remove the iLok during Pro Tools launch or use.

3 Do one of the following:

« On Mac, click the Pro Tools shortcut in your Dock (or double-click the application icon in
Macintosh HD/Applications/Avid/Pro Tools).

—_or-
« On Windows, double-click the Pro Tools shortcut on your desktop (or the application in
Program Files\Avid\Pro Tools).

4 Use the Quick Start dialog to do one of the following:
« Create a new session from a template.
« Create a new blank session.

« Open any other session on your system.

For more information about the Quick Start dialog and session templates, see the Pro Tools
Reference Guide.
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Configuring Your Pro Tools System

After you have installed, authorized, and launched Pro Tools software, you can configure
your Pro Tools system to meet the specific needs of your studio. For detailed information on
configuring your Pro Tools software, see the Pro Tools Reference Guide (which is available
from the Help menu in Pro Tools).

Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional documentation and software for your Pro Tools
system in the Additional Files folder.

Documentation

The Documentation folder contains PDF documentation for Pro Tools software, hardware,
plug-ins, and options.

Tech Support

The Tech Support folder contains PDF documentation, information about online resources,
and Pro Tools sessions for troubleshooting your Pro Tools system.

Optional Installers

The Optional Installers folder contains installers for Pro Tools software options that can be
purchased and authorized separately.

HEAT

(Avid HDX and Pro Tools|HD Systems Only)

HEAT (Harmonically Enhanced Algorithm Technology) is a paid software option that adds
“analog color” to Pro Tools HD with Avid HDX and Pro Tools|HD systems. For more information,
see the HEAT Software Option Guide.
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Pro Tools Demo Session
The Pro Tools Installer disc includes a demo session that you can use to verify that your system
is working correctly.

To install the demo session:

1 Insert the Pro Tools Installer disc into your DVD drive.

2 On the Pro Tools Installer disc, locate and open the Additional Files folder.
3 Copy the Pro Tools Demo Session folder to a valid audio drive.

4 Open the demo session.

Uninstalling Pro Tools

If you need to remove Pro Tools software from your computer, use the Uninstaller application
on Mac or use the Programs Control Panel on Windows.

Uninstalling Pro Tools on Mac

To uninstall Pro Tools on Mac:

1 Make sure you are logged in as an Administrator for the account where Pro Tools is installed.
2 Go to Applications/Avid/Pro Tools/Pro Tools Utilities and double-click Uninstall Pro Tools.
3 Click Continue to proceed with the uninstallation.

4 Choose the type of uninstall you want to perform:

Safe Uninstall. Leaves certain plug-ins and system files needed for compatibility with some
Avid products. Use Safe Uninstall if you are using an Avid application or preparing to update
to a CS (customer support) release.

Clean Uninstall. Removes all Pro Tools files, including system files, Avid plug-ins, and MIDI
patch names. Use Clean Uninstall whenever you are preparing to upgrade, or to troubleshoot
from a clean system.
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5 Click Uninstall.
6 Enter your Administrator password and click OK.

7 Click Finish to close the Installer window.

Uninstalling Pro Tools on Windows

To uninstall Pro Tools on Windows:

1 Choose Start > Control Panel.

2 Click Programs and Features.

3 Click Uninstall a program.

4 Select Avid Pro Tools from the list of installed applications.
5 Click Uninstall.

6 Follow the on-screen instructions to remove Pro Tools.

Q Note that you will have to uninstall plug-ins (such as Avid Effects), as well as any audio
" and MIDI device drivers separately.
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Optimizing a Mac System for Pro Tools
To ensure optimum performance with Pro Tools, configure your computer first.

Before configuring your computer, make sure you are logged in as an Administrator for the
account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X,
see your Apple OS X documentation.

A Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system
to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified
versions of Mac OS, see the latest compatibility information on our website (www.avid.com).

Turning Off Software Update

To turn off the Software Update feature:

1 Choose System Preferences from the Apple menu.
2 Click Software Update.

3 Click the Scheduled Check tab.

4 Deselect Check for updates.

5 When you are done, choose System Preferences > Quit System Preferences.

Turning Off Energy Saver

To turn off the Energy Saver feature:

1 Choose System Preferences from the Apple menu.

2 Click Energy Saver.

3 Set the Computer Sleep setting to Never.

4 Set the Display Sleep setting to Never.

5 Deselect “Put the hard disk(s) to sleep when possible” option.

6 When you are done, choose System Preferences > Quit System Preferences.
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Disable or Reassign Mac Keyboard Shortcuts Used by Pro Tools

To have the full complement of Pro Tools keyboard shortcuts, you need to disable or reassign
conflicting Mac OS X Keyboard Shortcuts in the Apple System Preferences.

For a complete list of Pro Tools keyboard shortcuts, see the Keyboard Shortcuts Guide (Help >
Keyboard Shortcuts).

To disable or reassign Mac keyboard shortcuts used by Pro Tools (Mac OS X Lion):
1 From the Apple menu, choose System Preferences.

2 Click Keyboard.

3 Click the Keyboard Shortcuts tab.

4 You can disable or reassign Mac OS keyboard shortcuts that conflict with Pro Tools keyboard
shortcuts. The following list includes several common Mac keyboard shortcuts that, depending
on the make and model of your Mac, may also used by Pro Tools:

« Under “Launchpad & Dock”

« “Turn Dock Hiding On/Off”
« Under “Mission Control”

» “Mission Control”

« “Application windows”

o “Show Desktop”

+ “Show Dashboard”

“Mission Control > Move left a space”
« “Mission Control > Move right a space”

« “Mission Control > Switch to Desktop n”
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« Under “Keyboard & Text Input”
« “Move focus to the window drawer”
« Under “Services”
« “Send File To Bluetooth Device”
o “Search With Google”
« “Spotlight”
« “Search Man Pages in Terminal”
« Under “Spotlight”
« “Show Spotlight search field”
« “Show Spotlight window”
« Under “Universal Access”
o “Zoom”
« “Contrast”
« Under “Application Shortcuts”

« “Show Help menu”

To disable or reassign Mac keyboard shortcuts used by Pro Tools (Mac OS X Snow Leopard):
1 From the Apple menu, choose System Preferences.

2 Click Keyboard.

3 Click the Keyboard Shortcuts tab.
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4 You can disable or reassign Mac OS keyboard shortcuts that conflict with Pro Tools keyboard
shortcuts. The following list includes several common Mac keyboard shortcuts that are also
used by Pro Tools:

« Under “Dashboard & Dock”
« “Turn Dock Hiding On/Off”
« “Dashboard”
« Under “Exposé and Spaces”
« “All windows”
« “Application windows”
« “Desktop”
« Under “Keyboard & Text Input”
« “Move focus to the window drawer”
« Under “Spotlight”
« “Show Spotlight search field”
« “Show Spotlight window”
« Under “Application Shortcuts”

o “Show Help menu”

Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically indexes files and folders on local hard drives in
the background. In most cases, this is not a concern for normal Pro Tools operation. However,
if Spotlight starts indexing drives while recording in a Pro Tools session with high track counts
for an extended period of time, it can adversely affect Pro Tools system performance. You may
want to disable Spotlight indexing for all local drives before using Pro Tools for big recording
projects.

A Disabling Spotlight indexing also disables the Find function in Mac 0S X.
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To disable Spotlight indexing:
1 Choose System Preferences from the Apple menu and click Spotlight.
2In the Spotlight window, click the Privacy tab.

3 To prevent indexing of a drive, drag its icon from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:
1 Launch the Disk Utility application, located in Applications/Utilities.
2 Select the volume in the left column of the Disk Utility window.

3 Select Enable Journaling in the toolbar.

Optimizing a Windows System for Pro Tools

To ensure optimum performance with Pro Tools, configure your computer before using Pro Tools
hardware and software.

Before configuring your computer, make sure you are logged in as an Administrator for the
account where you want to install Pro Tools. For details on Administrator privileges, see your
Windows documentation.

For the latest information about Windows system settings and for information about specific
computers, visit the Avid website (www.avid.com).
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Required Optimizations
To ensure optimum performance with Pro Tools, configure the following settings before using
Pro Tools hardware and software.

A When you are finished changing Windows system settings, restart your computer.

Disabling User Account Control

To disable User Account Control (UAC):

1 Choose Start > Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click on Change User Account Control settings.
5Set the slider to Never Notify.

6 Click OK.

Configuring System Standby and Power Management

When using Pro Tools, the Windows System Standby power scheme must be set to Always On.
This prevents long record or playback passes from stopping due to system resources powering
down.

To configure Windows Power Management:

1 Choose Start > Control Panel.

2 Click on System and Security.

3 Click Power Options.

4 Click on the arrow to Show Additional Plans.
5 Select High Performance.

6 Click Change plan settings.
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7 Click Change advanced power settings.
8In the Power Options dialog, reveal Hard disk > Turn off hard disk after.
9 Click Setting option.

10 Select the value in the Setting (Minutes) field and press Backspace on your computer
keyboard or scroll the value to Never.

11 Click OK. The hard disk setting changes to Never and the Power Options dialog closes.

121In the Edit Plan Settings window, click Save changes and close the window.

A Pro Tools automatically switches to the “High Performance” Power Management settings on
launch. Windows reverts to the previously selected Power Management settings (if different)
when exiting Pro Tools. Consequently, when optimizing the Power Management settings
for Pro Tools, you should always only optimize the High Performance configuration.

Recommended Optimizations

Pro Tools can also be affected by other software and hardware drivers installed on your computer.
For best possible performance, it is recommended (but not required) that you do the following:

+ Avoid running any unneeded programs at the same time as Pro Tools.

o Turn off any software utilities that run in the background, such as Windows Messenger,
calendars, and disk maintenance programs.

+ Turn off any non-essential USB devices while running Pro Tools.
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Optional Optimizations

The following system optimizations may help Pro Tools perform better on some systems. It is
recommended that you only try these optimizations if necessary, as they may disable or adversely
affect the functionality of other programs on your system.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1 Right-click Computer and choose Properties.

2 Click Advanced system settings.

3 Under the Performance section, click the Settings button.

41In the Performance Options window, click the Advanced tab.

5 Under the Processor Scheduling section, select the Background Services option.
6 Click OK to close the Performance Options window.

7 Click OK to close the System Properties window.

Disabling System Startup Items

The fewer items in use by your computer, the more resources are available for Pro Tools. Some
startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:
« Portable media serial number (required for some applications that utilize a copy protection
key)
« The Plug and Play service
« Event log

« Cryptographic services
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To Disable System Startup Items:

1 From the Start menu, type “msconfig” in Start Search and press Enter to open the System
Configuration Utility.

2 Under the General tab, choose Selective Startup.

3 Deselect Load Startup Items and click OK.

4 Click Restart to restart the computer.

5 After restarting, the computer displays a System Configuration message. Check to see if
Pro Tools performance has increased before you deselect the “Don't show this message again”
option. If performance has not changed, run “msconfig” and return your computer Startup

Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling
Startup items and non-essential processes individually.

Backing Up Your System

After setting up your system and installing Pro Tools, you should save an image of your system
drive using a backup utility. By doing this, you can quickly restore your system configuration
and settings if you encounter any problems.
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Installation du logiciel Pro Tools

Bienvenue dans le logiciel Avid Pro Tools®. Ce guide présente les procédures d'installation
et d'autorisation du logiciel Pro Tools sur les systémes Mac et Windows. Pour obtenir des
informations détaillées et exhaustives sur la configuration, les fonctionnalités et possibilités
de votre systéme Pro Tools, reportez-vous au Guide de référence Pro Tools (accessible a partir
du menu Help de Pro Tools).

Il existe quatre types de systémes Pro Tools :

Logiciel Pro Tools

Ces systémes incluent le logiciel Pro Tools et une interface audio de la famille Avid 003 ™ ou

Digi 002®, Eleven® Rack, Mbox® ou Mbox 2, ou du matériel M-Audio. Sont également qualifiés

les systémes composés du logiciel Pro Tools et d'interfaces audio tierces fonctionnant avec

des pilotes Core Audio (Mac, y compris systéme audio intégré des ordinateurs Mac) ou ASIO
(Windows) pris en charge.

Logiciel Pro Tools HD avec accélération matérielle

Systémes composés du logiciel Pro Tools HD et de matériel Avid HDX, Pro Tools|HD ou HD

Native. Les systémes a accélération matérielle fournissent des capacités d'E/S étendues et

permettent un monitoring a faible latence. Le logiciel Pro Tools HD associé 4 du matériel

Avid HDX ou Pro Tools|HD intégre également des DSP dédiés pour les traitements de plug-in

et les configurations de mixage les plus importantes.

Logiciel Pro Tools HD ou Pro Tools avec Complete Production Toolkit

Ces systémes incluent le logiciel Pro Tools HD ou Pro Tools avec l'option Complete Production

Toolkit et tout matériel Avid, Core Audio ou ASIO compatible.

Logiciel Pro Tools Express

Ces systémes incluent le logiciel Pro Tools Express et une interface audio de la famille Mbox
(3e génération). Pour plus d'informations, consultez le Guide d'installation de Pro Tools Express.
O Pour consulter la liste des interfaces audio et ordinateurs qualifiés avec l'ensemble des

systémes Pro Tools, rendez-vous sur www.avid.com/compatibility.
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Configuration requise et compatibilité

Pro Tools peut étre utilisé avec une interface audio qualifiée et sur un ordinateur Windows ou
Mac, lui aussi qualifié.

Un lecteur DVD est requis pour l'utilisation du disque d'installation de Pro Tools.

Une connexion Internet est nécessaire pour le téléchargement du programme d'installation de
Pro Tools.

Avid ne peut assurer une compatibilité des produits et fournir une assistance que pour les
matériels et les logiciels testés et approuvés par ses soins.

Pour connaitre la configuration requise et consulter la liste exhaustive des ordinateurs, systémes
d'exploitation, disques durs et périphériques tiers pris en charge, rendez-vous sur :

www.avid.com/compatibility

Autorisation iLok

Le package logiciel Pro Tools standard comprend une clé iLok sur laquelle est stockée
l'autorisation de votre copie du logiciel Pro Tools. Les packages matériels Pro Tools contiennent
une clé iLok ne contenant aucune autorisation et un code d'activation pour l'autorisation de
votre logiciel Pro Tools. Pour plus d'informations, reportez-vous a la section « Autorisation
de Pro Tools » ala page 27.

A Une clé iLok contenant l'autorisation du logiciel Pro Tools doit étre insérée dans un port
USB disponible de votre ordinateur afin de pouvoir lancer l'application.

Configuration MIDI requise

Les interfaces USB, FireWire et MIDI PCI fonctionnent de maniére optimale avec les systémes
Pro Tools sous Mac ou Windows. Les interfaces MIDI série sont prises en charge sur les systémes
Windows uniquement.

Pour obtenir la liste des interfaces et controleurs MIDI compatibles, rendez-vous sur
www.avid.com
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Configuration requise des disques durs

Pour une qualité d'enregistrement et de lecture audio optimale, tous les systémes Pro Tools
nécessitent 1'utilisation d'un ou plusieurs disques durs qualifiés.

Formatez vos disques durs al'aide de I'application Utilitaire de disque incluse dans vos logiciels
systéme Apple (Mac) ou du Gestionnaire de disques de Windows.

Enregistrement déconseillé sur le disque systeme

L'enregistrement audio sur votre disque systéme est possible, mais déconseillé. Les disques
durs systéme affichent parfois des performances inférieures en enregistrement et en lecture,
ce qui se traduit par un nombre inférieur de pistes et de plug-ins exploitables.

\Q’ L'utilitaire DigiBase permet de désigner le disque systéme comme disque de lecture ou de
transfert uniquement et ainsi d'obtenir des performances optimales. Pour plus d'informations,
consultez le Guide de référence Pro Tools.

Autorisation de Pro Tools

L'autorisation du logiciel Pro Tools est activée a 1'aide de la c1é USB iLok Smart Key (ci-apres
iLok) de PACE Anti-Piracy. La clé peut stocker des centaines d'autorisations pour I'ensemble
de vos logiciels activés par iLok. Lorsque l'autorisation d'un logiciel spécifique a été transférée
sur une clé iLok, vous pouvez l'utiliser sur n'importe quel ordinateur sur lequel le logiciel est
installé.

Clé USB iLok

L
Q’ Vous pouvez utiliser la nouvelle version de la clé iLok (représentée ci-dessus) ou sa version
= précédente pour conserver vos autorisations Pro Tools.
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Autorisation de Pro Tools HD

Une autorisation Pro Tools HD permet d'exploiter le logiciel Pro Tools HD sur un ordinateur
Mac ou Windows pris en charge, avec ou sans matériel Avid HDX, Pro Tools|HD ou HD Native.
Elle permet également d'utiliser le logiciel Pro Tools HD avec une autre interface audio qualifiée
par Avid telle qu'une Mbox Pro ou une Fast Track, ou toute autre interface audio tierce prenant
en charge des pilotes Core Audio (Mac) ou ASIO (Windows).

Autorisation de Pro Tools

Une autorisation Pro Tools permet d'exploiter le logiciel Pro Tools sur un ordinateur Mac ou
Windows pris en charge avec une interface audio qualifiée par Avid telle qu'une Mbox Pro ou
une Fast Track, ou toute autre interface audio tierce prenant en charge des pilotes Core Audio
(Mac) ou ASIO (Windows).

A Une autorisation Pro Tools ne permet pas d'utiliser le logiciel Pro Tools HD. Si vous lancez
le logiciel Pro Tools sur un systéme comprenant du matériel HDX, Pro Tools|HD ou HD
Native sans autorisation Pro Tools HD, il s'ouvrira s'il peut utiliser le systéme audio intégré
ou toute autre interface audio via un pilote Core Audio ou ASIO, mais il ne pourra pas
utiliser le matériel HDX, Pro Tools|HD ou HD Native installé.

Autorisation du Complete Production Toolkit

Si vous possédez une autorisation pour le Complete Production Toolkit ainsi que pour Pro Tools,
vous pouvez utiliser le logiciel Pro Tools ainsi que toutes les fonctionnalités du Complete
Production Toolkit. L'option logicielle Complete Production Toolkit pour Pro Tools prend en
charge un nombre supérieur de voix et de pistes et offre des fonctions de mixage surround,
d'édition et d'automation comparables a celles de Pro Tools HD.

Pour plus d'informations sur le Complete Production Toolkit, consultez le Guide Complete
Production Toolkit ou le Guide de référence Pro Tools.
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Ajout d'une autorisation a une clé iLok a I'aide d'un code d'activation
Si vous avez acheté une version boite neuve du logiciel Pro Tools, une clé iLok pré-autorisée
est fournie. Vous pouvez ignorer cette section et passer a la section « Installation de Pro Tools »
a la page 30.

Sivous avez acheté un nouveau systéme Avid HDX, Pro Tools|HD ou HD Native, une clé iLok
vide est fournie avec un code d'activation (sur la carte d'activation incluse) pour l'autorisation
du logiciel Pro Tools HD. Veuillez suivre les instructions ci-dessous.

Sivous effectuez une mise a niveau a partir d'une version antérieure du logiciel Pro Tools, un
code d'activation est fourni (sur la carte d'activation incluse) pour l'autorisation de votre
mise a niveau. Veuillez suivre les instructions ci-dessous.

Pour utiliser le code d'activation de I'autorisation du logiciel Pro Tools :

1Si vous ne possédez pas de compte iLok.com, rendez-vous sur www.iLok.com et créez un
compte.

2 Pour transférer la licence de votre logiciel sur votre compte iLok.com, procédez comme suit :
» Rendez-vous sur www.avid.com/activationcard.
- et -

« Saisissez votre code d'activation (indiqué sur votre carte d'activation) et votre ID utilisateur
iLok.com. Il s'agit du nom spécifié lors de la création de votre compte iLok.com.

3 Transférez les licences de votre compte iLok.com vers votre clé USB iLok Smart Key en
procédant comme suit :

o Insérez la clé iLok dans un port USB disponible de votre ordinateur.
« Rendez-vous sur www.iLok.com et connectez-vous a votre compte.

« Suivez les instructions a 'écran pour transférer vos licences vers votre clé iLok.

Pour plus d'informations, consultez le site Web iLok (www.iLok.com).
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Installation de Pro Tools

A Pour effectuer une mise a niveau de Pro Tools, assurez-vous d'avoir au préalable désinstallé
la version précédente du logiciel. Reportez-vous a la section « Désinstallation de Pro Tools »
a la page 39.

Présentation de l'installation

L'installation de Pro Tools inclut les étapes suivantes :

1 « Installation des pilotes matériels » a la page 30.

2 « Installation du logiciel Pro Tools » ala page 31.

3 « Installation d'instruments virtuels Avid » a la page 35 (facultative).
4 « Lancement de Pro Tools » ala page 37.

5 Configuration de votre systéme pour I'optimisation des performances (reportez-vous au
Guide de référence Pro Tools).

6 Connexions audio a votre interface audio. Pour plus d'informations, reportez-vous a la
documentation fournie avec votre interface audio.

Installation des pilotes matériels

Avant d'installer le logiciel Pro Tools, assurez-vous d'avoir installé votre matériel audio ainsi
que les derniers pilotes pour vos périphériques. Pour plus d’informations, reportez-vous a la
documentation fournie avec votre matériel. Pour les interfaces audio Avid, installez les pilotes
requis en sélectionnant le programme d'installation correspondant sur le disque inclus dans
le package d'installation de Pro Tools, ou rendez-vous sur le site www.avid.com/drivers pour
télécharger et installer les derniers pilotes disponibles.
" Pour le matériel Avid HDX, Pro Tools|HD et HD Native uniquement, le programme
d'installation de Pro Tools installe automatiquement les pilotes adéquats.
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A Pro Tools ne reconnaitra pas votre interface audio si ses pilotes ne sont pas installés. Pour
effectuer une mise a niveau de Pro Tools, assurez-vous d'avoir au préalable installé les
pilotes matériels les plus récents.

Installation du logiciel Pro Tools

Apreés avoir installé les pilotes de votre interface audio, vous pouvez installer Pro Tools.
A Avant d'installer cette version de Pro Tools, consultez le fichier Lisez-moi inclus.

Pour installer Pro Tools :

1 Assurez-vous que vous étes connecté en tant qu'administrateur pour le compte sur lequel
vous souhaitez installer Pro Tools.

2 Effectuez 1'une des opérations suivantes :

« Insérez le disque d'installation de Pro Tools dans votre lecteur DVD.
_ou-

o Téléchargez le programme d'installation de Pro Tools en ligne.

3 Effectuez 1'une des opérations suivantes :

« Sur Magc, localisez et double-cliquez sur le fichier Install Pro Tools.mpkg.

« Sous Windows, effectuez 'une des opérations suivantes :

« Sil'exécution automatique est activée, une fenétre apparait. Sélectionnez Install Pro Tools
pour commencer l'installation.

—ou -

« Sil'exécution automatique est désactivée, naviguez jusqu'au fichier Setup.exe, puis double-
cliquez dessus et sélectionnez 1'option Install Pro Tools pour lancer l'installation.
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A Sous Windows, si la boite de dialogue Contréle de compte utilisateur s'affiche, cliquez
sur Autoriser. Plusieurs messages s'affichent pendant l'installation, comme les boites de
dialogue « Nouveau matériel détecté » et « Un probléme est survenu pendant l'installation
du matériel ». Vous pouvez les ignorer. De plus, si un message d'avertissement indique que
le pilote n'a pas été validé lors du test permettant d'obtenir le logo Windows, cliquez sur
Continuer.

4 Suivez les instructions a I'écran pour continuer la procédure d'installation.
5 Sur la page de choix du type d'installation, sélectionnez 1'une des options suivantes :

« Pour installer tous les fichiers d'application Pro Tools et les suites de plug-ins gratuites (ainsi
que le contenu associé), conservez les options d'installation par défaut et cliquez sur Continuer.

_ou-
« Sélectionnez (ou désélectionnez) les options d'installation pour personnaliser l'installation

(reportez-vous a la section « Options d'installation » a la page 33), puis cliquez sur Continuer.
6 Cliquez sur Installer.

7 Le cas échéant, saisissez votre mot de passe administrateur et cliquez sur OK pour valider
I'installation.

8 Suivez les instructions a 1'écran jusqu'a la fin de la procédure.

9 Lorsque l'installation est terminée, cliquez sur Redémarrer (Mac) ou sur Terminer (Windows).

" Ledisque d'installation de Pro Tools contient des logiciels supplémentaires pour votre systéme.
Pour plus d'informations, reportez-vous a la section « Logiciels supplémentaires du disque
d'installation Pro Tools » a la page 38.
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Options d'installation

Options Pro Tools 10

Pour installer un sous-ensemble de logiciels et plug-ins Pro Tools, cliquez sur le triangle en
regard de 1'option Pro Tools 10.0 du programme d'installation, puis, parmi les options suivantes,
désélectionnez celles que vous ne souhaitez pas installer.

Application Files (Required for Pro Tools) : installe I'application Pro Tools et les fichiers de
bibliotheque annexes nécessaires pour exécuter Pro Tools. Cette option doit étre cochée pour
installer Pro Tools.

Avid Effects : installe les plug-ins d'effets audio Avid gratuits. Pour plus d'informations,
consultez le Guide des plug-ins audio.

Pro Tools Utilities : installe les utilitaires Pro Tools, tels que DigiTest, et désinstalle Pro Tools
(Mac uniquement).

Options supplémentaires

En plus du logiciel et des plug-ins Pro Tools, le programme d'installation de Pro Tools propose
les options supplémentaires suivantes.

Mac HFS+ Disk Support Option (Windows uniquement) : cette option permet a votre systeme
Pro Tools de lire et écrire des données, d'enregistrer et de lire de I'audio sur des disques Mac
formatés en HFS+. Les disques HFS+ sont aussi souvent appelés disques Mac OS étendus. Pour
plus d'informations, consultez le Guide de référence Pro Tools.

Avid Video Engine : le moteur vidéo Avid est requis pour utiliser Pro Tools avec des
périphériques vidéo Avid tels que Avid Mojo® SDI. Pour plus d'informations, reportez-vous
au Guide des périphériques vidéo Avid.
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Démarrage et arrét du systeme

Pour que les différents composants de votre systéme Pro Tools puissent communiquer
correctement entre eux, vous devez les mettre sous tension dans un ordre précis.
Démarrez votre systéme Pro Tools dans I'ordre suivant :

1 Assurez-vous que tous vos appareils (y compris votre ordinateur) sont éteints.

2 Baissez le volume de tous les périphériques de sortie du systéme.

3 Pour les systémes avec chassis d'extension, mettez ce dernier sous tension.

4 Mettez tous les disques durs externes sous tension. Patientez environ 10 secondes jusqu'a ce
qu'ils aient atteint leur vitesse nominale.

5 Mettez vos surfaces de contréle sous tension, le cas échéant.

6 Mettez les interfaces et périphériques MIDI, ou les périphériques de synchronisation sous
tension.

7 Mettez sous tension le matériel fonctionnant sur une source d'alimentation externe (interface
HD I/0 ou 003 par exemple). Patientez au moins pendant quinze secondes (durée d'initialisation
de l'interface audio). Les LED d'état cessent de clignoter.

8 Mettez l'ordinateur sous tension.

9 Lancez Pro Tools (reportez-vous a la section « Lancement de Pro Tools » a la page 37) ou
toute autre application tierce audio ou MIDI.

Arrétez votre systéme Pro Tools dans I'ordre suivant :
1 Quittez Pro Tools et toutes les autres applications ouvertes.

Pour quitter Pro Tools, sélectionnez Pro Tools > Quit (Mac) ou File > Exit (Windows).

2 Baissez le volume de tous les périphériques de sortie du systéme.

3 Mettez votre ordinateur hors tension.
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4 Mettez hors tension le matériel fonctionnant sur une source d'alimentation externe, pour les
systémes concernés.

5 Eteignez toutes les interfaces audio Pro Tools.
6 Pour les systemes avec chassis d'extension, mettez ce dernier sous tension.

7 Mettez hors tension les interfaces et périphériques MIDI ou les périphériques de
synchronisation.

8 Mettez hors tension les éventuelles surfaces de contréle ou de travail.

9 Mettez hors tension les disques durs externes.

Installation d'instruments virtuels Avid

Avid fournit une suite de plug-ins d'instruments virtuels gratuits avec les samples associés,
destinée a Pro Tools. Pour plus d'informations, consultez le Guide des plug-ins audio.
Pour installer les instruments virtuels Avid :

1 Assurez-vous que vous étes connecté en tant qu'administrateur pour le compte sur lequel
vous souhaitez installer les instruments virtuels Avid.

2 Effectuez 1'une des opérations suivantes :
« Insérez le disque d'installation de Pro Tools dans votre lecteur DVD.
~ou-

o Téléchargez le programme d'installation des instruments virtuels Avid et du contenu associé
en ligne.
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3 Effectuez 1'une des opérations suivantes :
o Sur Magc, localisez et double-cliquez sur le fichier Install Avid Virtual Instruments.mpkg.
« Sous Windows, effectuez 'une des opérations suivantes :

« Pour une installation & partir d'un disque, une fenétre s'ouvre si la fonction d'exécution
automatique de Windows est activée. Sélectionnez Install Avid Virtual Instruments pour
commencer l'installation.

« Pour une installation a partir d'un disque et si l'exécution automatique de Windows est
désactivée, naviguez jusqu'au fichier Setup.exe, puis double-cliquez dessus et sélectionnez
I'option Install Avid Virtual Instruments pour lancer l'installation.

« Sivous avez téléchargé le programme d'installation des instruments virtuels Avid, ouvrez
le fichier Avid Virtual Instruments.exe.

4 Suivez les instructions a I'écran pour continuer la procédure d'installation.

5 Cliquez sur Installer.

A La taille du contenu associé aux instruments virtuels est trés importante et son installation
peut prendre jusqu'a vingt minutes. Pendant ce temps, l'installation du logiciel progresse,
méme si la barre de progression ne semble pas l'indiquer. Ne quittez pas la procédure
d'installation.

6 Le cas échéant, saisissez votre mot de passe administrateur et cliquez sur OK pour valider
I'installation.

7 Suivez les instructions a I'écran jusqu'a la fin de la procédure.

8 Lorsque l'installation est terminée, cliquez sur Fermer (Mac) ou sur Terminer (Windows).
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Lancement de Pro Tools

Pour utiliser le logiciel Pro Tools, vous devez disposer d'une clé iLok contenant une licence
d'autorisation pour la version de Pro Tools que vous avez installée (pour plus d'informations,
reportez-vous a la section « Autorisation de Pro Tools » a la page 27).

Pour lancer le logiciel Pro Tools :

1 Vérifiez que votre interface audio est bien connectée a votre ordinateur et sous tension.

2 Insérez une clé iLok autorisée dans un port USB disponible de votre ordinateur (reportez-vous
a la section « Autorisation de Pro Tools » a la page 27).

A Ne débranchez pas la clé iLok lors de I'ouverture ou de l'utilisation de Pro Tools.

3 Effectuez 1'une des opérations suivantes :

« Sur Mac, cliquez sur le raccourci Pro Tools du Dock ou double-cliquez sur I'icone de
I'application sous Macintosh HD/Applications/Avid/Pro Tools.

_ou-
« Sous Windows, double-cliquez sur le raccourci Pro Tools du bureau ou sur l'application située
dans le dossier Programmes\Avid\Pro Tools.
4 Utilisez la boite de dialogue Quick Start pour effectuer 1'une des opérations suivantes :
« Créer une nouvelle session a partir d'un modele.
« Créer une nouvelle session vierge.

« Ouvrir une autre session présente sur votre systéme.

Pour plus d'informations sur la boite de dialogue Quick Start et les modéles de session,
consultez le Guide de référence Pro Tools.
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Configuration de votre systéeéme Pro Tools

Une fois que vous avez installé, autorisé et ouvert le logiciel Pro Tools, vous pouvez configurer
votre systéme pour répondre aux besoins spécifiques de votre studio. Pour obtenir des
informations supplémentaires sur la configuration du logiciel Pro Tools, reportez-vous au
Guide de référence Pro Tools (disponible a partir du menu Help de Pro Tools).

Logiciels supplémentaires du disque d'installation Pro Tools

Le disque d'installation de Pro Tools fournit de la documentation et des logiciels supplémentaires
pour votre systéeme Pro Tools, disponibles dans le dossier Additional Files.

Documentation

Le dossier Documentation contient des documents au format PDF concernant le logiciel, le
matériel, les plug-ins et les options de Pro Tools.

Tech Support

Le dossier Tech Support contient de la documentation au format PDF, des informations sur
les ressources disponibles en ligne et sur les sessions Pro Tools de dépannage de votre systéme.

Optional Installers

Le dossier Optional Installers contient des programmes d'installation d'options logicielles de
Pro Tools que vous pouvez acheter et autoriser séparément.

HEAT

(systéemes Avid HDX et Pro Tools|HD uniquement)

HEAT (Harmonically Enhanced Algorithm Technology) est une option logicielle payante
pour Pro Tools HD qui ajoute une « couleur analogique » au son des systémes Avid HDX et
Pro Tools|HD. Pour plus d'informations, reportez-vous au Guide de l'option logicielle HEAT.
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Session de démonstration Pro Tools
Le disque d'installation de Pro Tools contient une session de démonstration permettant de
vérifier le bon fonctionnement de votre systéme.

Pour installer la session de démonstration :

11Insérez le disque d'installation de Pro Tools dans votre lecteur DVD.

2 Sur le disque d'installation de Pro Tools, localisez et ouvrez le dossier Additional Files.
3 Copiez le dossier de la session de démonstration Pro Tools sur un lecteur audio valide

4 Ouvrez la session de démonstration.

Désinstallation de Pro Tools

Si vous souhaitez désinstaller le logiciel Pro Tools de votre ordinateur, utilisez 'application
de désinstallation sur Mac ou I'utilitaire Désinstaller ou modifier un programme de Windows.

Désinstallation de Pro Tools sur Mac

Pour désinstaller Pro Tools sur Mac :

1 Assurez-vous que vous étes connecté en tant qu'administrateur au compte sur lequel Pro Tools
est installé.

2 Accédez a I'emplacement Applications/Avid/Pro Tools/Pro Tools Utilities, puis double-cliquez
sur le fichier Uninstall Pro Tools.

3 Cliquez sur Continuer pour initier la procédure de désinstallation.
4 Sélectionnez le type de désinstallation a effectuer :

Safe Uninstall : conserve des fichiers systéme et de plug-in requis pour la compatibilité avec
certains produits Avid. Optez pour cette désinstallation partielle si vous utilisez une application
Avid ou effectuez une mise a jour vers une version CS (service clients).
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Clean Uninstall : supprime tous les fichiers Pro Tools, y compris les fichiers systéme, les plug-ins
Avid et les noms de patch MIDI. Optez pour cette désinstallation compléte si vous effectuez une
mise a niveau ou souhaitez corriger des problémes en repartant d'un systéme propre.

5 Cliquez sur Désinstaller.
6 Entrez le mot de passe administrateur, puis cliquez sur OK.

7 Cliquez sur Terminer pour fermer la fenétre du programme d'installation.

Désinstallation de Pro Tools sous Windows

Pour désinstaller Pro Tools sous Windows :

1 Sélectionnez Démarrer > Panneau de configuration.

2 Cliquez sur Programmes et fonctionnalités.

3 Cliquez sur Désinstaller un programme.

4 Sélectionnez Avid Pro Tools dans la liste des applications installées.
5 Cliquez sur Désinstaller.

6 Suivez les instructions & 1'écran pour désinstaller Pro Tools.

Q Notez que vous devrez désinstaller séparément les plug-ins, tels que les effets Avid, ainsi
" que tous les pilotes audio et MIDI.
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Optimisation d'un systéeme Mac pour Pro Tools

Pour garantir des performances optimales avec Pro Tools, commencez par configurer votre
ordinateur.

Avant de configurer votre ordinateur, assurez-vous que vous étes connecté en tant
qu'administrateur pour le compte sur lequel vous souhaitez installer Pro Tools. Pour obtenir des
détails sur les privileges d'administrateur sous Mac OS X, reportez-vous a votre documentation
Apple OS X.

A N'utilisez pas la fonction de mise a jour logicielle automatique de Mac OS X, car cela peut
entrainer une mise d jour de votre systéme avec une version de Mac OS qui n'a pas été
qualifiée pour Pro Tools. Pour plus de détails sur les versions de Mac OS qualifiées, reportez-
vous aux informations de compatibilité accessibles sur notre site Web (www.avid.com).

Désactivation de la mise a jour logicielle

Pour désactiver la fonction de mise a jour logicielle :

1 Dans le menu Pomme, sélectionnez Préférences Systeme.

2 Cliquez sur Mise a jour de logiciels.

3 Cliquez sur 'onglet Planification des vérifications.

4 Désélectionnez l'option Rechercher les mises a jour.

5 Ensuite, sélectionnez Préférences Systéme > Quitter les Préférences Systéeme.
Désactivation de I'économiseur d'énergie

Pour désactiver I'économiseur d'énergie :

1 Dans le menu Pomme, sélectionnez Préférences Systéme.

2 Cliquez sur Economiseur d'énergie.

3 Définissez le Mode de veille sur Jamais.

4 Définissez le paramétre de Veille d'affichage sur Jamais.

5 Désélectionnez Suspendre dés que possible I'activité du ou des disques durs.

6 Ensuite, sélectionnez Préférences Systéme > Quitter les Préférences Systéme.
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Désactivation ou réassignation des raccourcis clavier Mac utilisés par
Pro Tools

Pour exploiter tous les raccourcis clavier que propose Pro Tools, vous devez désactiver ou
réassigner les éventuels raccourcis clavier Mac OS X en conflit dans les préférences systeme
Apple.

Pour obtenir une liste compléte des raccourcis clavier Pro Tools, reportez-vous au Guide des
raccourcis clavier (Help > Keyboard Shortcuts).

Pour désactiver ou réassigner les raccourcis clavier Mac utilisés par Pro Tools (Mac OS X Lion) :
1 Dans le menu Pomme, sélectionnez Préférences Systéme.

2 Cliquez sur Clavier.

3 Cliquez sur 'onglet Raccourcis clavier.

4 Vous pouvez désactiver ou réassigner les raccourcis clavier Mac OS en conflit avec ceux de
Pro Tools. La liste suivante répertorie plusieurs raccourcis clavier Mac courants qui peuvent
également étre utilisés par Pro Tools, en fonction du modele et de la configuration de votre Mac :

» Sous « Launchpad et Dock »
o « Activer/désactiver le masquage du Dock »

Sous « Mission Control »

« Mission Control »

« Fenétres d'applications »

« Afficher le bureau »

« Afficher le Dashboard »

« Mission Control > Déplacer d'un espace vers la gauche »

« Mission Control > Déplacer d'un espace vers la droite »

« Mission Control > Passer au Bureau n »
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Sous « Saisie de texte »

« « Déplacer le focus sur le volet de la fenétre »
Sous « Services »

» « Envoyer le fichier vers un appareil Bluetooth »
« « Rechercher avec Google »

« «Spotlight »

« « Rechercher dans les pages de manuels »
Sous « Spotlight »

» « Afficher le champ de recherche Spotlight »
« « Afficher la fenétre Spotlight »

Sous « Acces universel »

e «Zoom »

« « Contraste »

Sous « Raccourcis d'applications »

o « Afficher le menu Aide »

Pour désactiver ou réassigner les raccourcis clavier Mac utilisés par Pro Tools (Mac OS X Snow
Leopard) :

1 Dans le menu Pomme, sélectionnez Préférences Systéme.
2 Cliquez sur Clavier.
3 Cliquez sur 'onglet Raccourcis clavier.

4 Vous pouvez désactiver ou réassigner les raccourcis clavier Mac OS en conflit avec ceux
de Pro Tools. La liste suivante répertorie plusieurs raccourcis clavier Mac courants qui sont
également utilisés par Pro Tools :

« Sous « Dashboard et Dock »

o « Activer/désactiver le masquage du Dock »
o « Dashboard »
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« Sous « Exposé et Spaces »
« « Toutes les fenétres »
« « Fenétres d'applications »
» « Bureau »
« Sous « Saisie de texte »
« « Déplacer le focus sur le volet de la fenétre »
« Sous « Spotlight »
« « Afficher le champ de recherche Spotlight »
+ « Afficher la fenétre Spotlight »
« Sous « Raccourcis d'applications »

o « Afficher le menu Aide »

Désactivation de I'indexation Spotlight

La fonction Spotlight de Mac OS X indexe automatiquement les fichiers et dossiers des disques
durs locaux en arriére-plan. Dans la plupart des cas, cela ne perturbe pas le fonctionnement
de Pro Tools ; cependant, si Spotlight lance I'indexation des disques durs lors d'un enregistrement
dans une session Pro Tools comportant un nombre de piste élevé, les performances du systéme
Pro Tools peuvent étre affectées. Pour les projets d'enregistrement Pro Tools les plus importants,
il est conseillé de désactiver l'indexation Spotlight pour tous les disques locaux.

A Notez que cela désactivera également la fonction Rechercher de Mac OS X.

Pour désactiver I'indexation Spotlight :
1Dans le menu Pomme, sélectionnez Préférences Systéme, puis cliquez sur Spotlight .
2 Dans la fenétre Spotlight, cliquez sur I'onglet Confidentialité.

3 Faites glisser I'icone du disque que vous ne souhaitez pas indexer du bureau vers la liste.
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Activation de la journalisation des lecteurs audio

Les performances des lecteurs audio peuvent étre améliorées en activant la journalisation.

Pour activer la journalisation :
1Dans le dossier Applications/Utilitaires, démarrez l'application Utilitaire de disque.
2 Sélectionnez le volume dans la colonne de gauche de la fenétre Utilitaire de disque.

3 Sélectionnez Activer la journalisation dans la barre d'outils.

Optimisation d'un systéeme Windows pour Pro Tools

Pour des performances optimales avec Pro Tools, configurez votre ordinateur avant d'utiliser
le matériel et le logiciel Pro Tools.

Avant de configurer votre ordinateur, assurez-vous que vous étes connecté en tant
qu'administrateur pour le compte sur lequel vous souhaitez installer Pro Tools. Pour tout
renseignement complémentaire sur les priviléges d'administrateur, reportez-vous a votre
documentation Windows.

Pour accéder aux informations les plus récentes sur le paramétrage des systémes Windows
et sur la configuration d'ordinateurs spécifiques, rendez-vous sur le site Web Avid

(www.avid.com).

Optimisations nécessaires
Pour garantir des performances optimales, configurez les paramétres suivants avant d'utiliser
le logiciel Pro Tools.

A Redémarrez votre ordinateur aprés avoir modifié les paramétres systéme de Windows.
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Désactivation du contrdole de compte d'utilisateur
Pour désactiver le controle de compte d'utilisateur :

1 Sélectionnez Démarrer > Panneau de configuration.

2 Cliquez sur Comptes et protection des utilisateurs.

3 Cliquez sur Comptes d'utilisateur.

4 Cliquez sur Modifier les paramétres de controle de compte d'utilisateur.
5 Déplacez le curseur sur Ne jamais m'avertir.

6 Cliquez sur OK.

Configuration de la mise en veille et de la gestion de I'alimentation

Si vous utilisez Pro Tools, le mode de mise en veille du systéme Windows doit étre défini sur
Toujours actif. Cela permet d'éviter qu'une longue session d'enregistrement ou de lecture soit
interrompue inopinément & cause de l'arrét de ressources systéme.

Pour configurer la gestion de I'alimentation Windows :

1 Sélectionnez Démarrer > Panneau de configuration.

2 Cliquez sur Systéme et sécurité.

3 Cliquez sur Options d'alimentation.

4 Cliquez sur la fleche pour Afficher les modes supplémentaires.

5 Sélectionnez Performances élevées.

6 Cliquez sur Modifier les parameétres du mode.

7 Cliquez sur Modifier les paramétres d'alimentation avancés.

8 Dans la boite de dialogue Options d'alimentation, développez l'option Disque dur > Arréter le
disque dur apres.

9 Cliquez sur l'option Paramétre.
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10 Sélectionnez une valeur dans le champ Parametre (Minutes) et appuyez sur la touche Retour
arriére du clavier ou sélectionnez Jamais dans la liste déroulante.

11 Cliquez sur OK. Le paramétre du disque dur est défini sur Jamais et la boite de dialogue
Options d'alimentation se ferme.

12 Dans la fenétre Modifier les parameétres du mode de gestion de I’alimentation, cliquez sur
Enregistrer les modifications puis fermez la fenétre.

A Lors de son ouverture, Pro Tools modifie automatiquement les paramétres d'alimentation en les
définissant sur Performances élevées. Si vous les aviez modifiés, les paramétres d'alimentation
d'origine de Windows sont rétablis lorsque vous quittez le logiciel Pro Tools. Par conséquent,
lorsque vous souhaitez optimiser les paramétres de gestion de l'alimentation pour Pro Tools,
vous devez configurer uniquement le mode Performances élevées.

Optimisations recommandées

D'autres pilotes logiciels et matériels installés sur votre ordinateur peuvent également interférer
avec Pro Tools. Pour obtenir des performances optimales, nous vous suggérons d'effectuer les
opérations suivantes :

« Evitez d'exécuter simultanément Pro Tools et des programmes dont vous n'avez pas
absolument besoin.

« Désactivez les logiciels qui fonctionnent en tache de fond, tels que Windows Messenger,
les calendriers et les programmes de maintenance de disque.

» Lorsque vous exécutez Pro Tools, éteignez tous les périphériques USB non indispensables.
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Optimisations facultatives

Les optimisations du systéme suivantes peuvent améliorer les performances de Pro Tools sur
certains systémes. Il est reccommandé de ne recourir a ces optimisations qu'en cas de nécessité,
car elles peuvent désactiver ou compromettre certaines fonctionnalités d'autres programmes
installés sur votre systeme.

Réglage de la planification du processeur

Pour régler les performances de planification du processeur :

1 Cliquez avec le bouton droit de la souris sur Ordinateur, puis sélectionnez Propriétés.

2 Cliquez sur Paramétres systéme avancés.

3 Dans la zone Performances, cliquez sur le bouton Paramétres.

4 Dans la fenétre Options de performances, cliquez sur l'onglet Avancé.

5 Dans la section Performance des applications, sélectionnez l'option Services d'arriére-plan.
6 Cliquez sur OK pour fermer la fenétre Options de performances.

7 Cliquez sur OK pour fermer la fenétre Propriétés systéme.

Désactivation des éléments de démarrage du systéme

Moins les processus actifs sur votre ordinateur sont nombreux, plus les ressources disponibles

pour Pro Tools sont importantes. Certaines applications de démarrage consomment inutilement
les ressources du processeur et peuvent étre désactivées.

Ne désactivez les éléments de démarrage suivants qu'en toute connaissance de cause :

« le numéro de série d'un support mobile (nécessaire aux applications utilisant une clé de
protection contre la copie) ;

« le service Plug and Play ;
« le journal d'événements ;

« les services cryptographiques.
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Pour désactiver les éléments de démarrage du systéme :
1 Depuis le menu Démarrer, saisissez « msconfig » dans la zone de recherche et appuyez sur
Entrée pour ouvrir l'utilitaire de configuration du systéme.

2 Sous l'onglet Général, sélectionnez Démarrage sélectif.
3 Désactivez l'option Charger les éléments de démarrage, puis cliquez sur OK.
4 Cliquez sur Redémarrer pour redémarrer 1'ordinateur.

5 Apres le redémarrage, un message relatif a la configuration systéme s'affiche a I'écran. Vérifiez
que les performances de Pro Tools ont été améliorées avant de désactiver la case « Ne plus
afficher ce message ». Si les performances n'ont pas été améliorées, exécutez l'utilitaire msconfig
et sélectionnez le mode Démarrage normal (charger tous les pilotes de périphérique et tous les
services) au lieu du mode de démarrage sélectif, ou désactivez un par un les éléments lancés au
démarrage et les processus non indispensables.

Sauvegarde de votre systéeme

Une fois la configuration du systeme et l'installation de Pro Tools terminées, enregistrez une
image de votre disque systéme a I'aide d'un utilitaire de sauvegarde. Cette opération vous permet,
en cas de problémes, de restaurer rapidement la configuration et les paramétres de votre systéme.
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Installieren der Pro Tools-Software

Willkommen bei Pro Tools® von Avid. In diesem Handbuch erfahren Sie, wie Sie Thre Pro Tools-
Software auf Mac- und Windows-Systemen installieren und autorisieren. Nahere Informationen
zur Konfiguration Ihres Pro Tools-Systems sowie iiber dessen volle Funktionalitit erhalten Sie
im Pro Tools-Referenzhandbuch (Zugriff iber das Hilfemeni in Pro Tools).

Es gibt vier Arten von Pro Tools-Systemen:

Pro Tools-Software

Zu diesen Systemen gehdrt Pro Tools-Software zusammen mit Audio-Interfaces der Produktfamilien
Avid 003™, Digi 002®, Eleven® Rack, Mbox®und Mbox 2 oder M-Audio-Hardware. Die in diesen
Systemen enthaltene Pro Tools-Software kann auch mit Audio-Interfaces anderer Hersteller,
die Core Audio-Treiber (Mac, einschlief8lich der im Mac integrierten Audiofunktionen) oder
ASIO-Treiber (Windows) unterstiitzen, eingesetzt werden.

Pro Tools HD-Software mit Hardwarebeschleunigung

Zu diesen Systemen gehort Pro Tools HD zusammen mit Avid HDX, Pro Tools|HD- oder HD Native-
Hardware. Systeme mit Hardwarebeschleunigung bieten erweiterte Anschlussméglichkeiten und
Niedriglatenz-Monitoring. Pro Tools HD-Software mit Avid HDX- oder Pro Tools|HD-Hardware
bietet DSP-Leistung eigens fiir Plug-In-Verarbeitung und grofle Mixer-Konfigurationen.
Pro Tools HD-Software und Pro Tools-Software mit Complete Production Toolkit

Zu diesen Systemen gehoren Pro Tools HD- oder Pro Tools-Software mit Complete Production
Toolkit zusammen mit kompatibler Avid-, Core Audio- oder ASIO-Hardware.

Pro Tools Express-Software

Zu diesen Systemen gehort Pro Tools Express-Software zusammen mit Audio-Interfaces der
Mbox-Produktfamilie (3. Generation). (Weitere Informationen hierzu finden Sie im Pro Tools
Express-Installationshandbuch.)

\Q’ Eine Liste der qualifizierten Audio-Interfaces und Computer fiir alle Pro Tools-Systeme finden
© Sie unter: www.avid.com/compatibility.
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Systemanforderungen und Kompatibilitat

Pro Tools kann auf einem qualifizierten Windows- oder Mac-Computer mit einem qualifizierten
Audio-Interface eingesetzt werden.

Zur Verwendung des Pro Tools-Installationsdatentragers ist ein DVD-Laufwerk erforderlich.
Fiir den Download des Pro Tools-Installationsprogramms bendtigen Sie eine Internetverbindung.
Avid kann die Kompatibilitdt und technische Unterstiitzung nur fiir Hardware- und Softwarekom-
ponenten zusichern, die entsprechend gepriift und genehmigt wurden.
Die kompletten Systemanforderungen und eine Liste der qualifizierten Computer, Betriebssysteme,
Festplatten und Gerite von Drittanbietern finden Sie auf der Website:

www.avid.com/compatibility

Autorisierter iLok

Das Standard-Pro Tools-Software-Paket umfasst einen bereits autorisierten iLok fiir die Pro Tools-
Software. Zum Lieferumfang von Hardware-Systemen mit Pro Tools gehdren ein nicht autorisierter
iLok und ein Aktivierungscode fiir Thre Pro Tools-Autorisierung. Weitere Informationen hierzu
finden Sie unter ,Autorisieren von Pro Tools“ auf Seite 53.

A Damit Sie Pro Tools verwenden kénnen, muss ein autorisierter iLok in einen USB-Anschluss
Ihres Computers eingesteckt sein.

MIDI-Anforderungen

USB-, FireWire- und PCI MIDI-Interfaces funktionieren mit Pro Tools-Systemen auf Mac oder
unter Windows. Serielle MIDI-Interfaces werden nur auf Windows-Systemen unterstiitzt.

Eine Liste der unterstiitzten MIDI-Interfaces und MIDI-Controller finden Sie auf www.avid.com.
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Anforderungen an die Festplatten
Fiir eine optimale Audioaufnahme und -wiedergabe benotigen alle Pro Tools-Systeme mindestens
eine von Avid qualifizierte Festplatte.

Initialisieren Sie Ihre Festplatte mit dem Festplatten-Dienstprogramm in der Apple-Systemsoftware
(Mac) oder mit der Windows-Datentridgerverwaltung (Windows).

Nicht auf das Systemlaufwerk aufnehmen

Das Aufnehmen auf das Systemlaufwerk ist méglich, aber nicht empfehlenswert. Bei Aufnahme
und Wiedergabe auf Systemlaufwerken konnen weit weniger Spuren und Plug-Ins verwendet werden.

\Q’ Fiir optimale Leistung kann es von Vorteil sein, Ihr Systemlaufwerk mit DigiBase als Laufwerk
= nur fiir die Wiedergabe oder nur fiir die Ubertragung einzurichten. Weitere Informationen
hierzu finden Sie im Pro Tools-Referenzhandbuch.

Autorisieren von Pro Tools

Pro Tools-Software wird mit Hilfe des iLok USB Smart Key (iLok) von PACE Anti-Piracy autorisiert.
EiniLok kann iiber 100 Autorisierungen fiir alle Ihre iLok-geschiitzten Anwendungen speichern.
Nachdem ein iLok fiir eine bestimmte Software autorisiert wurde, konnen Sie mit dem iLok
diese Software auf einem beliebigen Computer autorisieren.

iLok USB Smart Key

\Q’ Sie konnen fiir Ihre Pro Tools-Autorisierungen entweder die neue Version des iLok (abgebildet)
~ oder die vorherige Version des iLok verwenden.
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Pro Tools HD-Autorisierung

Mit einer Pro Tools HD-Autorisierung konnen Sie Pro Tools HD auf einem unterstiitzten Mac-
oder Windows-Computer mit oder ohne Avid HDX, Pro Tools|HD- oder HD Native-Hardware
ausfithren. Mit einer Autorisierung fiir Pro Tools HD konnen Sie Pro Tools HD auch mit jedem
anderen von Avid qualifizierten Audio-Interface (wie Mbox Pro oder Fast Track) ausfithren
oder mit einem Audio-Interface eines anderen Herstellers, das Core Audio- (Mac) oder ASIO-
Geritetreiber (Windows) unterstiitzt.

Pro Tools-Autorisierung

Mit einer Autorisierung fiir Pro Tools konnen Sie Pro Tools-Software auf einem unterstiitzten
Mac- oder Windows-Computer mit einem von Avid qualifizierten Audio-Interface (wie Mbox
Pro oder Fast Track) ausfithren oder mit einem Audio-Interface eines anderen Herstellers, das
Core Audio- (Mac) oder ASIO-Geritetreiber (Windows) unterstiitzt.

A Eine Pro Tools-Autorisierung geniigt nicht fiir die Ausfiihrung der Pro Tools HD-Software.
Wenn Sie versuchen, Pro Tools-Software auf einem System mit HDX, Pro Tools|HD- oder
HD Native-Hardware ohne eine Pro Tools HD-Autorisierung zu starten, startet die Pro Tools-
Software zwar, wenn sie Core Audio oder ASIO mit integriertem Sound oder einem anderen
Audio-Interface verwenden kann, es kann aber installierte HDX-, Pro Tools|HD- oder HD
Native-Hardware nicht nutzen.

Complete Production Toolkit-Autorisierung

Eine Complete Production Toolkit-Autorisierung zusammen mit einer Pro Tools-Autorisierung
erméglicht die Ausfithrung von Pro Tools-Software und die Nutzung aller Funktionen von
Complete Production Toolkit. Mit der Pro Tools-Softwareoption Complete Production Toolkit
stehen zusitzliche Spuren und spielbare Spuren (Voices) sowie Funktionen fiir Surround-Mischen,
-Editing und -Automation zur Verfiigung, die das Niveau von Pro Tools HD erreichen.

Weitere Hinweise zu Complete Production Toolkit finden Sie im Handbuch zu Complete
Production Toolkit sowie im Pro Tools-Referenzhandbuch.
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Autorisieren des iLok mit einem Aktivierungscode

Wenn Sie eine neue Version von Pro Tools-Software als Box-Version gekauft haben, ist ein bereits
autorisierter iLok enthalten. In diesem Fall konnen Sie diesen Abschnitt iiberspringen und bei
»Installieren von Pro Tools“ auf Seite 56 weiterlesen.

Wenn Sie ein neues Avid HDX-, Pro Tools|HD- oder HD Native-System gekauft haben, wird dieses
mit einem leeren iLok und einem Aktivierungscode (auf der mitgelieferten Aktivierungskarte)
zur Autorisierung von Pro Tools HD-Software geliefert. Folgen Sie zur Autorisierung den
nachstehenden Anweisungen.

Upgrades von einer fritheren Version der Pro Tools-Software umfassen einen Aktivierungscode
(auf der beigelegten Aktivierungskarte), mit dem Sie Ihr Software-Upgrade auf Ihrem iLok
autorisieren. Folgen Sie zur Autorisierung den nachstehenden Anweisungen.

So autorisieren Sie lhre Pro Tools-Software mit einem Aktivierungscode:

1 Wenn Sie kein iLok.com-Konto haben, erstellen Sie eines auf www.iLok.com.

2 Ubertragen Sie die Lizenz fiir Thre Software folgendermafien auf Ihr iLok.com-Konto:
» Besuchen Sie www.avid.com/activationcard.
- und -

« Geben Sie Ihren Aktivierungscode (auf Ihrer Aktivierungskarte aufgefithrt) und Ihre
iLok.com-Anwender-ID ein. Ihre iLok.com-Anwender-ID ist der Name, den Sie fiir Thr
iLok.com-Konto erstellt haben.

3 Ubertragen Sie die Lizenzen von Threm iLok.com-Konto wie folgt auf Ihren iLok USB Smart Key:
« Stecken Sie den iLok in einen USB-Anschluss am Computer.
+ Gehen Sie zu www.iLok.com und melden Sie sich an.

« Folgen Sie den Anweisungen am Bildschirm, um Ihre Lizenzen auf Thren iLok zu iibertragen.

Weitere Informationen erhalten Sie auf der iLok-Website (www.iLok.com).
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Installieren von Pro Tools

A Wenn Sie ein Pro Tools-Upgrade durchfiihren, deinstallieren Sie zuerst dltere Pro Tools-
Versionen von Ihrem Computer. Siehe ,Deinstallieren von Pro Tools“ auf Seite 65.

Uberblick zur Installation

Bei der Installation von Pro Tools sind die folgenden Schritte auszufiihren:

1 ,Installieren von Hardware-Treibern® auf Seite 56

2 ,Installieren der Pro Tools-Software“ auf Seite 57

3 ,Installieren von virtuellen Instrumenten® auf Seite 61 (optional)

4 ,Starten von Pro Tools“ auf Seite 62

5 Konfigurieren Ihres Systems zur Leistungsoptimierung (siehe Pro Tools-Referenzhandbuch)

6 Herstellen der Audioverbindungen zu Ihrem Audio-Interface (sieche Dokumentation zu Threm
Audio-Interface)

Installieren von Hardware-Treibern

Bevor Sie die Pro Tools-Software installieren, miissen Sie sicherstellen, dass Ihre Audio-Hardware
installiert ist und die neuesten Treiber fiir Ihre Hardware eingerichtet wurden. Weitere Hinweise
hierzu finden Sie in der Dokumentation zu IThrer Hardware. Fiir Avid-Audio-Interfaces installieren
Sie die Treiber Threr Hardware mit dem entsprechenden Treiberinstallationsprogramm auf der DVD,
die mit Ihrer Pro Tools-Installation mitgeliefert wurde, oder Sie laden sie von www.avid.com/drivers
herunter und installieren sie auf Threm Gerit.

" Das Pro Tools-Installationsprogramm installiert die erforderlichen Hardwaretreiber nur fiir
Avid HDX-, Pro Tools|HD-Systeme und HD Native-Hardware automatisch.

A Pro Tools erkennt Ihre Audio-Interfaces nicht, wenn Sie die Treiber nicht installieren. Wenn
Sie ein Upgrade von Pro Tools vornehmen, achten Sie darauf, die neuesten Treiber fiir Ihre
Hardware zu installieren.
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Installieren der Pro Tools-Software
Nachdem Sie die Treiber fiir Ihr Audio-Interface installiert haben, koénnen Sie Pro Tools installieren.

A Lesen Sie vor dem Installieren dieser Version von Pro Tools die Informationen in der Readme-
Datei.

So installieren Sie Pro Tools:
1 Sie miissen als Administrator fiir das Konto angemeldet sein, fiir das Sie Pro Tools installieren
mdochten.
2 Sie haben folgende Moglichkeiten:
« Legen Sie den Pro Tools-Installationsdatentriger in das DVD-Laufwerk ein.
- oder -
« Laden Sie das Installationsprogramm fiir Pro Tools herunter.
3 Sie haben folgende Mdglichkeiten:
« Suchen Sie auf dem Mac die Datei Install Pro Tools.mpkg und doppelklicken Sie darauf.
« Unter Windows fithren Sie einen der folgenden Schritte aus:
« Wenn Windows Autorun aktiviert ist, wird ein Mini-Browser gedffnet. Wihlen Sie Install
Pro Tools, um mit der Installation zu beginnen.
- oder -
« Wenn Sie von der DVD installieren und Windows Autorun deaktiviert ist, doppelklicken
Sie auf die Datei Setup.exe und wihlen Sie dann Install Pro Tools, um mit der Installation zu
beginnen.

A Unter Windows klicken Sie im Dialogfeld der Benutzerkontensteuerung auf ,,Erlauben .
Wiihrend der Installation werden mehrere Meldungen angezeigt, die ignoriert werden kénnen,
darunter mehrfache ,Neue Hardware gefunden“-Dialogfelder und ,, Wihrend der Hardware-
installation ist ein Problem aufgetreten“-Meldungen. Sollte aufferdem an dieser Stelle
eine Warnmeldung beziiglich des nicht bestandenen Windows-Logo-Tests eines Treibers
angezeigt werden, ignorieren Sie diese und klicken Sie auf , Weiter®.
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4 Folgen Sie den Installationsanweisungen auf dem Bildschirm, um mit der Installation fortzufahren.

5 Auf der Installationsart-Seite gehen Sie wie folgt vor:

« Wenn Sie alle Pro Tools-Anwendungsdateien und die kostenlosen Plug-In-Suites (sowie die
dazugehorigen Inhalte) installieren méchten, lassen Sie die Standardoptionen fiir die Installation
unverdndert und klicken Sie auf Continue.

- oder -

« Wihlen Sie die Option zur benutzerdefinierten Konfiguration oder heben Sie diese Auswahl auf

(siehe ,Installationsoptionen auf Seite 58) und klicken Sie auf Continue.

6 Klicken Sie auf Install.

7 Geben Sie bei entsprechender Aufforderung das Administrator-Kennwort ein und klicken Sie zum
Ausfithren der Installation auf OK.

8 Folgen Sie den weiteren Anweisungen auf dem Bildschirm.

9 Wenn die Installation abgeschlossen ist, klicken Sie auf Restart (Mac) oder Finish (Windows).

\Q’ Die Pro Tools-Installations-DVD enthilt weitere Software fiir Ihr System. Weitere Informati-

©  onen hierzu finden Sie unter , Weitere Software auf der Pro Tools-Installations-DVD“ auf
Seite 64.

Installationsoptionen

Optionen fiir Pro Tools 10

Wenn Sie nur einen Teil der Pro Tools-Software und -Plug-Ins installieren médchten, klicken Sie
im Installationsprogramm auf das Dreieckszeichen fiir Pro Tools 10 und heben Sie die Auswahl
der Optionen, die Sie nicht installieren mochten, auf.

Application Files (Required for Pro Tools) - damit werden die Pro Tools-Software und die
dazugehorigen Bibliotheksdateien installiert. Diese Option muss aktiviert sein, um Pro Tools
zu installieren.

Avid Effects - installiert kostenlose Audio-Effekt-Plug-Ins von Avid. Weitere Informationen
finden Sie im Audio-Plug-Ins-Handbuch.
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Pro Tools Utilities - installiert Pro Tools-Dienstprogramme wie DigiTest und das Deinstallations-
programm ,,Uninstall Pro Tools“ (nur Mac).

Weitere Optionen

Das Pro Tools-Installationsprogramm bietet die folgenden zusétzlichen Optionen zur Installation
mit Pro Tools-Software und -Plug-Ins.

Mac HFS+ Disk Support Option (nur Windows) — mit dieser Option kann das Pro Tools-System
auf in HFS+ formatierten Mac-Festplatten lesen, schreiben, aufzeichnen und wiedergeben.
Festplatten des Typs HFS+ werden auch als Mac OS Extended-Festplatten bezeichnet. Weitere
Informationen hierzu finden Sie im Pro Tools-Referenzhandbuch.

Avid Video Engine — die Avid Video Engine ist erforderlich, um Pro Tools mit Avid-Video-
peripheriegeriten wie Avid Mojo® SDI zu verwenden. Weitere Informationen hierzu finden
Sie im Handbuch zu Avid-Videoperipheriegerdten.

Starten bzw. Herunterfahren des Systems

Damit die einzelnen Komponenten Ihres Pro Tools-Systems ordnungsgemaf miteinander
kommunizieren konnen, miissen sie in einer bestimmten Reihenfolge gestartet werden.

Starten Sie das Pro Tools-System in dieser Reihenfolge:

1 Vergewissern Sie sich, dass samtliche Gerite (einschlieflich des Computers) ausgeschaltet sind.
2 Reduzieren Sie die Lautstirke aller Ausgabegerite des Systems.

3 Schalten Sie bei Systemen mit Erweiterungschassis zuerst dieses Chassis ein.

4 Schalten Sie alle externen Festplatten ein. Warten Sie 10 Sekunden, bis diese ihre Betriebsge-
schwindigkeit erreicht haben.

5Schalten Sie alle Bedienoberflichen ein.

6 Schalten Sie MIDI-Interfaces, MIDI-Gerite und/oder Synchronisationseinheiten ein.
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7 Bei Systemen, die eine externe Stromversorgung bendtigen, schalten Sie dann die Hardware
ein (wie etwa HD I/0 oder 003). Warten Sie mindestens 15 Sekunden, bis das Audio-Interface
initialisiert ist. Die Status-LEDs horen dann auf zu blinken.

8 Schalten Sie Thren Computer ein.
9 Starten Sie Pro Tools (siehe ,,Starten von Pro Tools“ auf Seite 62) bzw. Audio- oder MIDI-

Anwendungen anderer Hersteller.

Fahren Sie das Pro Tools-System in der folgenden Reihenfolge herunter:
1 Beenden Sie Pro Tools und alle anderen laufenden Anwendungen.

Um Pro Tools zu beenden, wihlen Sie ,,Pro Tools > Quit“(Mac) oder , File > Exit“ (Windows).

2 Schalten Sie die Ausgabegerite des Systems aus oder reduzieren Sie die Lautstirke auf das
Minimum.

3 Schalten Sie Ihren Computer aus.

4 Bei Systemen mit Hardware, die eine externe Stromversorgung benétigt, schalten Sie die
Hardware aus.

5 Schalten Sie die Pro Tools-Audio-Interfaces ein.

6 Schalten Sie bei Systemen mit Erweiterungschassis zuerst dieses Chassis aus.
7 Schalten Sie MIDI-Interfaces, MIDI-Geréte und Synchronisationsgerite aus.
8 Schalten Sie alle Bedienoberfliachen aus.

9 Schalten Sie die externen Festplatten aus.
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Installieren von virtuellen Instrumenten

Avid bietet eine Zusammenstellung virtueller Instrumenten-Plug-Ins und dazugehériger Sample-
Inhalte fiir die Verwendung mit Pro Tools. Weitere Informationen finden Sie im Audio-Plug-
Ins-Handbuch.

So installieren Sie Avid Virtual Instruments:

1 Sie miissen als Administrator fiir das Konto angemeldet sein, fiir das Sie Avid Virtual Instruments

installieren mochten.

2 Sie haben folgende Moglichkeiten:

« Legen Sie den Pro Tools-Installationsdatentriger in das DVD-Laufwerk ein.
- oder -

« Laden Sie das Installationsprogramm fiir Avid Virtual Instruments sowie die zugehorigen
Inhalte von der Website herunter.

3 Sie haben folgende Moglichkeiten:

« Suchen Sie auf dem Mac die Datei Install Avid Virtual Instruments.mpkg und doppelklicken Sie
darauf.

« Unter Windows fithren Sie einen der folgenden Schritte aus:

« Wenn Sie von der DVD installieren und Windows Autorun aktiviert ist, wird ein Mini-Browser
geoffnet. Wihlen Sie Install Avid Virtual Instruments, um mit der Installation zu beginnen.

« Wenn Sie von der DVD installieren und Windows Autorun deaktiviert ist, doppelklicken
Sie auf die Datei Setup.exe und wihlen Sie dann Install Avid Virtual Instruments, um mit der
Installation zu beginnen.

« Wenn Sie das Installationsprogramm fiir Avid Virtual Instruments heruntergeladen haben,
fithren Sie die Datei Avid Virtual Instruments.exe aus.

4 Folgen Sie den Installationsanweisungen auf dem Bildschirm, um mit der Installation fortzufahren.
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5Klicken Sie auf Install.

A Die Inhalte fiir virtuelle Instrumente sind sehr umfangreich und die Installation kann bis
zu 20 Minuten dauern. Es kann wihrend dieser Zeit den Anschein haben, dass sich der
Fortschrittsbalken nicht bewegt, aber die Software wird trotzdem installiert. Brechen Sie
die Installation nicht ab.

6 Geben Sie bei entsprechender Aufforderung das Administrator-Kennwort ein und klicken
Sie zum Ausfiithren der Installation auf OK.

7 Folgen Sie den weiteren Anweisungen auf dem Bildschirm.

8 Wenn die Installation abgeschlossen ist, klicken Sie auf Close (Mac) bzw. Finish (Windows).

Starten von Pro Tools

Um Pro Tools-Software einsetzen zu konnen, miissen Sie iiber einen iLok mit einer Lizenz verfiigen,
die die von Thnen installierte Pro Tools-Version autorisiert (weitere Informationen finden Sie
unter ,Autorisieren von Pro Tools“ auf Seite 53).

So starten Sie die Pro Tools-Software:

1 Vergewissern Sie sich, dass das Audio-Interface mit dem Computer verbunden und eingeschaltet ist.

2 Stecken Sie einen autorisierten iLok in einen USB-Anschluss am Computer (siehe ,, Autorisieren
von Pro Tools“ auf Seite 53).

A Entfernen Sie den iLok wihrend des Starts und der Verwendung von Pro Tools nicht.
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3 Sie haben folgende Moglichkeiten:

« Auf dem Mac klicken Sie auf den Pro Tools-Schnellaufruf in Threm Dock (oder doppelklicken
Sie auf das Programmsymbol in Macintosh HD/Programme/Avid/Pro Tools).
- oder -

« Unter Windows doppelklicken Sie auf die Pro Tools-Verkniipfung auf Threm Desktop (oder auf
die Anwendungsdatei in Programme\Avid\Pro Tools).

4Im Quick Start-Dialogfeld haben Sie folgende Moglichkeiten:
« Erstellen einer neuen Session aus einer Vorlage
« Erstellen einer neuen leeren Session

« Offnen einer anderen Session in Threm System

Weitere Informationen zu Quick Start-Dialogfeld und Session-Vorlagen finden Sie im
Pro Tools-Referenzhandbuch.

Konfigurieren des Pro Tools-Systems

Nachdem Sie die Pro Tools-Software installiert, autorisiert und gestartet haben, konnen Sie
Ihr Pro Tools-System konfigurieren, um es an die besonderen Anforderungen Ihres Studios
anzupassen. Detaillierte Hinweise zur Konfiguration Ihrer Pro Tools-Software finden Sie im
Pro Tools-Referenzhandbuch (im Hilfemenii von Pro Tools).

Installieren der Pro Tools-Software 63



Weitere Software auf der Pro Tools-Installations-DVD

Auf der Pro Tools-Installations-DVD finden Sie im Ordner Additional Files weitere Dokumentation
und Software fiir Thr Pro Tools-System.

Dokumentation
Im Documentation-Ordner finden Sie PDF-Dokumentation fiir Pro Tools-Software, -Hardware,
-Plug-Ins und -Optionen.

Technische Hilfe
Im Tech Support-Ordner finden Sie die PDF-Dokumentation, Informationen iiber Online-
Ressourcen und Pro Tools-Sessions fiir die Fehlersuche in Threm Pro Tools-System.

Optionale Installationsprogramme

Der Optional Installers-Ordner enthalt Installationsprogramme fiir Pro Tools-Softwareoptionen,
die separat erworben und autorisiert werden kénnen.

HEAT

(Nur Avid HDX und Pro Tools|HD-Systeme)

HEAT (Harmonically Enhanced Algorithm Technology) ist eine Softwareoption, die Pro Tools HD
zusammen mit Avid HDX und Pro Tools|HD-Systemen ,analoges Feeling“ verleiht. Weitere
Informationen hierzu finden Sie im HEAT-Handbuch.

Pro Tools-Demo-Session

Die Pro Tools-Installations-DVD enthilt eine Demo-Session, mit deren Hilfe Sie feststellen
kénnen, ob Ihr System funktioniert.

So installieren Sie die Demo-Session:

1 Legen Sie die Installations-DVD fiir Pro Tools in das DVD-Laufwerk ein.

2 Offnen Sie auf der Pro Tools Installations-DVD den Additional Files-Ordner.

3 Kopieren Sie den Pro Tools Demo Session-Ordner auf ein giiltiges Audiolaufwerk.

4 Offnen Sie die Demo-Session.
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Deinstallieren von Pro Tools

Wenn Sie Pro Tools von IThrem Computer entfernen mochten, benutzen Sie auf dem Mac die
Uninstaller-Anwendung und unter Windows in der Systemsteuerung die Option ,Programme*.

Deinstallieren von Pro Tools auf dem Mac

So deinstallieren Sie Pro Tools auf dem Mac:

1 Vergewissern Sie sich, dass Sie als Administrator fiir das Konto angemeldet sind, fiir das
Pro Tools installiert ist.

2 Rufen Sie das Verzeichnis Programme/Avid/Pro Tools/Pro Tools Utilities auf und doppelklicken
Sie auf die Datei Uninstall Pro Tools.

3 Klicken Sie auf Continue, um mit der Deinstallation fortzufahren.
4 Wihlen Sie die durchzufithrende Deinstallationsart:

Safe Uninstall - bei dieser Deinstallationsart werden bestimmte Plug-Ins und Systemdateien,
die zur Kompatibilitat mit einigen Avid-Produkten erforderlich sind, nicht entfernt. Verwenden
Sie ,,Safe Uninstall, wenn Sie eine Avid-Anwendung verwenden oder eine Aktualisierung auf
eine CS-Version (Customer Support) planen.

Clean Uninstall — alle Pro Tools-Dateien werden entfernt, einschliefSlich Systemdateien, Avid-
Plug-Ins und MIDI-Patch-Namen. Verwenden Sie ,,Clean Uninstall®, wenn Sie eine Aktualisierung
planen oder ein neu installiertes System zur Fehlerbehebung bendtigen.

5Klicken Sie auf Uninstall.
6 Geben Sie Thr Administratorkennwort ein und klicken Sie auf OK.

7 Klicken Sie auf Finish, um das Installationsfenster zu schlieffen.
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Deinstallieren von Pro Tools unter Windows

So deinstallieren Sie Pro Tools unter Windows:

1 Wihlen Sie Start > Systemsteuerung.

2 Klicken Sie auf Programme und Funktionen.

3 Klicken Sie auf Programm deinstallieren.

4 Wihlen Sie Avid Pro Tools aus der Liste installierter Anwendungen.
5 Klicken Sie auf Deinstallieren.

6 Folgen Sie den Bildschirmanweisungen, um Pro Tools zu entfernen.

Q Beachten Sie, dass Plug-Ins (wie Avid Effects) sowie Audio- und MIDI-Geriitetreiber separat
" deinstalliert werden miissen.

Optimieren eines Mac-Systems fiir Pro Tools

Damit Pro Tools optimal funktioniert, miissen Sie den Computer vor der Verwendung der
Pro Tools-Software konfigurieren.

Vor dem Konfigurieren Ihres Computers miissen Sie als Administrator fiir das Konto angemeldet
sein, fiir das Sie Pro Tools installieren mochten. Weitere Informationen zur Anmeldung als
Administrator auf Mac OS X finden Sie in der Apple-Dokumentation zu OS X.

A Verwenden Sie keinesfalls die Funktion zur automatischen Software-Aktualisierung von
Mac 0S X, da sonst méglicherweise eine Version von Mac OS installiert wird, die noch nicht
fiir die Verwendung mit Pro Tools qualifiziert wurde. Weitere Informationen zu empfohlenen
Versionen von Mac OS erhalten Sie in den aktuellen Kompatibilititsinformationen auf der
Avid-Website (www.avid.com).
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Deaktivieren der Software-Aktualisierung

So deaktivieren Sie die Software-Aktualisierung:

1 Wihlen Sie aus dem Apple-Menii Systemeinstellungen.

2 Klicken Sie auf Softwareaktualisierung.

3 Klicken Sie auf die Registerkarte PlanmaRige Uberpriifung.

4 Deaktivieren Sie Nach Updates suchen.

5 Wihlen Sie anschlieend Systemeinstellungen > Systemeinstellungen beenden.
Deaktivieren der Energiesparfunktion

So deaktivieren Sie die Funktion ,,Energie sparen*:

1 Wihlen Sie aus dem Apple-Menii Systemeinstellungen.

2 Klicken Sie auf Energie sparen.

3 Setzen Sie die Einstellung fiir den Ruhezustand des Computers auf Nie.

4 Setzen Sie die Einstellung fiir den Ruhezustand des Monitors auf Nie.

5 Heben Sie die Auswahl der Option Wenn méglich Ruhezustand der Festplatte(n) aktivieren auf.

6 Wihlen Sie anschlieSend Systemeinstellungen > Systemeinstellungen beenden.

Deaktivieren oder Neuzuordnen der Mac-Tastenkombinationen fiir Pro Tools

Um alle Pro Tools-Tastenkombinationen verwenden zu kénnen, miissen Sie zuerst dazu im
Widerspruch stehende Mac OS X-Tastenkombinationen in den Apple-Systemeinstellungen
deaktivieren oder neu zuordnen.

Eine volistindige Liste der Pro Tools-Tastenkombinationen finden Sie in der Dokumentation
zu den Tastenkombinationen (Help > Keyboard Shortcuts).
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So deaktivieren Sie Mac-Tastenkombinationen fiir Pro Tools oder ordnen sie neu zu (Mac OS X Lion):
1 Wihlen Sie aus dem Apple-Menii die Option Systemeinstellungen.

2 Klicken Sie auf Tastatur & Maus.

3 Klicken Sie auf die Registerkarte Tastatur-Kurzbefehle.

4 Sie konnen die Mac OS-Tastenkombinationen, die mit den Pro Tools-Tastenkombinationen
in Konflikt stehen, deaktivieren oder neu programmieren. Die folgende Liste enthilt einige
hiufige Mac-Tastenkombinationen, die je nach Mac-Modell moglicherweise auch von Pro Tools
benutzt werden:

« Unter ,Launchpad & Dock®
o Dock ein- oder ausblenden
« Unter ,Mission Control®

Mission Control

Programmfenster
Schreibtisch einblenden

Dashboard einblenden

Mission Control > Einen Space nach links bewegen

Mission Control > Einen Space nach rechts bewegen

Mission Control > Zu Schreibtisch n wechseln

« Unter ,Tastatur & Texteingabe“

« Fokus zum aktiven oder nachsten Fenster bewegen
« Unter ,Dienste

« Datei an Bluetooth-Gerdt senden

« Mit Google suchen

« Spotlight

» In man-Seiten im Terminal suchen
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« Unter ,,Spotlight*
« Spotlight-Suchfeld einblenden
« Spotlight-Fenster einblenden
« Unter ,Universal Access“
« Zoom
« Kontrast
« Unter dem Menii fiir Programm-Kurzbefehle
« Hilfemenii einblenden
So deaktivieren Sie Mac-Tastenkombinationen fiir Pro Tools oder ordnen sie neu zu (Mac OS X Snow
Leopard):
1 Wihlen Sie aus dem Apple-Menii die Option Systemeinstellungen.
2 Klicken Sie auf Tastatur & Maus.
3 Klicken Sie auf die Registerkarte Tastatur-Kurzbefehle.

4 Sie konnen die Mac OS-Tastenkombinationen, die mit den Pro Tools-Tastenkombinationen
in Konflikt stehen, deaktivieren oder neu programmieren. Die folgende Liste enthilt einige
hédufige Mac-Tastenkombinationen, die auch von Pro Tools verwendet werden:

o Unter ,Dashboard & Dock"
» Dock ein- oder ausblenden
« Dashboard
« Unter ,,Exposé & Spaces®
« Alle Fenster
« Programmfenster
« Schreibtisch
«+ Unter ,Tastatur & Texteingabe“
« Fokus zum aktiven oder nachsten Fenster bewegen
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« Unter ,Spotlight*

« Spotlight-Suchfeld einblenden

« Spotlight-Fenster einblenden
« Unter dem Menii fiir Programm-Kurzbefehle

« Hilfemenii einblenden
Deaktivieren der Spotlight-Indizierung
Die Spotlight-Funktion von Mac OS X indiziert automatisch im Hintergrund Dateien und Ordner
auf lokalen Festplatten. Dies ist fiir die normalen Pro Tools-Funktionen in den meisten Fillen
kein Problem. Wenn aber Spotlight mit dem Indizieren der Festplatten wihrend einer linger
dauernden Aufnahme in einer Pro Tools-Sitzung mit vielen Spuren beginnt, kann das die Leistung
des Pro Tools-Systems deutlich vermindern. Es kann also sinnvoll sein, die Spotlight-Indizierung
fiir alle lokalen Festplatten zu deaktivieren, bevor Sie mit Pro Tools gréfere Aufnahmeprojekte
durchfiihren.

A Durch das Deaktivieren der Spotlight-Indizierung wird auch die Suchfunktion in Mac 0S X
deaktiviert.

So deaktivieren Sie die Spotlight-Indizierung:

1 Wihlen Sie aus dem Apple-Menii Systemeinstellungen und klicken Sie auf Spotlight.

2 Klicken Sie im Spotlight-Fenster auf die Registerkarte Privatsphare.

3 Um die Indizierung eines Laufwerks zu verhindern, ziehen Sie das entsprechende Laufwerkssym-
bol vom Schreibtisch in die Liste.

Aktivieren von Journaling fiir Audiolaufwerke

Um die Leistung der Audiolaufwerke zu verbessern, kénnen Sie Journaling aktivieren.

So aktivieren Sie Journaling:
1 Starten Sie das Festplattendienstprogramm (im Ordner ,,Programme/Dienstprogramme*).

2 Wiihlen Sie in der linken Spalte des Festplatten-Dienstprogramm-Fensters das Volume aus.

3 Wihlen Sie in der Symbolleiste Journaling aktivieren.
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Optimieren eines Windows-Systems fiir Pro Tools

Damit Pro Tools optimal funktioniert, miissen Sie den Computer vor der Verwendung der
Pro Tools-Hardware und -Software konfigurieren.

Vor dem Konfigurieren Ihres Computers miissen Sie als Administrator fiir das Konto angemeldet
sein, fiir das Sie Pro Tools installieren mdchten. Weitere Informationen hierzu finden Sie in
der Windows-Dokumentation.

Aktuelle Informationen zu Windows-Systemeinstellungen sowie Informationen zu bestimmten
Computern finden Sie auf der Avid-Website (www.avid.com).

Erforderliche OptimierungsmafRnahmen

Fiir eine optimale Leistung von Pro Tools sollten Sie vor dem Verwenden der Pro Tools-Hardware
und -Software die im Folgenden beschriebenen Einstellungen vornehmen.

A Nachdem Sie die erforderlichen Windows-Systemeinstellungen geindert haben, starten Sie
den Computer neu.

Benutzerkontensteuerung deaktivieren

So deaktivieren Sie die Benutzerkontensteuerung:

1 Wihlen Sie Start > Systemsteuerung.

2 Klicken Sie auf Benutzerkonten und Jugendschutz.

3 Klicken Sie auf Benutzerkonten.

4 Klicken Sie auf Einstellungen der Benutzerkontensteuerung éndern.
5Setzen Sie den Schieberegler auf Nie benachrichtigen.

6 Klicken Sie auf OK.
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Konfigurieren von System-Standby und Energieverwaltung

Bei der Arbeit mit Pro Tools muss das Energieschema fiir Windows-System-Standby immer auf
Dauerbetrieb gesetzt sein. Dadurch wird vermieden, dass lange Aufnahme- oder Wiedergabedurch-
laufe aufgrund eines plotzlichen Ausfalls der Systemressourcen unterbrochen werden.

So konfigurieren Sie die Windows-Energieverwaltung:

1 Wihlen Sie Start > Systemsteuerung.

2 Klicken Sie auf System und Sicherheit.

3 Klicken Sie auf Energieoptionen.

4 Klicken Sie auf den Pfeil fiir die Option Weitere Energiesparpléne einblenden.

5 Wihlen Sie Hohe Leistung.

6 Klicken Sie auf Energiesparplaneinstellungen &ndern.

7 Klicken Sie auf Erweiterte Energieeinstellungen dndern.

8 Im Dialogfeld der Energieoptionen suchen Sie Festplatte > Festplatte ausschalten nach.

9 Klicken Sie auf die Option Einstellungen.

10 Wihlen Sie im Feld fiir die Einstellung der Minuten den gewiinschten Wert und driicken Sie
die Riicktaste auf der Computertastatur oder setzen Sie den Wert auf Nie.

11 Klicken Sie auf OK. Die Festplatteneinstellung dndert sich auf Nie und das Dialogfeld fiir
die Energieoptionen wird geschlossen.

12 Klicken Sie im Fenster ,,Energiesparplaneinstellungen bearbeiten® auf Anderungen speichern
und schlieflen Sie das Fenster.

A Pro Tools aktiviert beim Start automatisch die Energiespareinstellung ,,Hohe Leistung*.
Windows kehrt in die vorher ausgewdihlte Energiespareinstellung zuriick, wenn Pro Tools
beendet wird. Wenn Sie also die Energiespareinstellung fiir Pro Tools dndern michten,
brauchen Sie nur die Energiespareinstellung ,Hohe Leistung*“ einzustellen.

72 Installieren der Pro Tools-Software



Empfohlene Optimierungsmafinahmen

Andere auf dem Computer installierte Software- und Hardwaretreiber konnen sich auf die Leistung
von Pro Tools auswirken. Beachten Sie die folgenden Empfehlungen, um eine optimale Leistung
mit Pro Tools zu erzielen:

« Nicht erforderliche andere Programme sollten nicht gleichzeitig mit Pro Tools ausgefiihrt
werden.

» Deaktivieren Sie im Hintergrund ausgefiihrte Dienstprogramme (wie Windows Messenger,
Kalender und Datentriger-Wartungsprogramme).

« Schalten Sie wihrend der Arbeit mit Pro Tools alle nicht unbedingt erforderlichen USB-
Gerite aus.

Optionale OptimierungsmafRnahmen

Die folgenden Mafinahmen zur Systemoptimierung steigern die Leistung von Pro Tools auf
manchen Systemen. Sie sollten diese Optimierungseinstellungen nur vornehmen, wenn dies
unbedingt notig ist, da sie sich auf die Funktion anderer Programme Ihres Systems auswirken
konnen.

Einstellen der Prozessorzeitplanung

So stellen Sie die Prozessorzeitplanung ein:

1 Klicken Sie mit der rechten Maustaste auf das Symbol Arbeitsplatz und wihlen Sie Eigenschaften.
2 Klicken Sie auf Erweiterte Systemeinstellungen.

3 Klicken Sie unter ,Leistung® auf die Schaltfliche Einstellungen.

4 Klicken Sie im Dialogfeld ,Leistungsoptionen® auf die Registerkarte Erweitert.

5 Wihlen Sie im Abschnitt ,,Prozessorzeitplanung“ die Option Hintergrunddienste.

6 Klicken Sie auf OK, um das Dialogfeld ,Leistungsoptionen® zu schliefen.

7 Klicken Sie auf OK, um das Dialogfeld ,Systemeigenschaften zu schliefen.
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Deaktivieren von Elementen fiir den Systemstart

Je weniger Elemente von IThrem Computer benutzt werden, desto mehr Ressourcen sind fiir
Pro Tools verfiigbar. Manche Systemstartelemente verbrauchen unnétigerweise Rechnerressourcen
und sollten daher deaktiviert werden.

Gehen Sie beim Deaktivieren der folgenden Systemstartelemente sorgfiltig vor:
« Seriennummer der tragbaren Medien (fiir einige Anwendungen mit einem Kopierschutz-
schliissel benotigt)
o Plug & Play-Dienst
« Ereignisprotokoll
« Kryptografiedienste

So deaktivieren Sie Elemente fiir den Systemstart:

1 Wihlen Sie im Startmenii die Option ,Ausfithren®, geben Sie ,,msconfig“ ein und driicken Sie
die Eingabetaste, um das Dienstprogramm zur Systemkonfiguration aufzurufen.

2 Wiihlen Sie auf der Registerkarte Allgemein die Option Benutzerdefinierter Systemstart.

3 Deaktivieren Sie Systemstartelemente laden und klicken Sie auf OK.

4 Klicken Sie auf Neu starten, um den Computer neu zu starten.

5 Nach dem Neustart wird eine Meldung zur Systemkonfiguration angezeigt. Starten Sie Pro Tools
und dberpriifen Sie, ob die Leistung verbessert wurde, bevor Sie die Option ,Diese Meldung
nicht mehr anzeigen® aktivieren. Hat sich die Leistung nicht verbessert, fithren Sie ,msconfig*
erneut aus und setzen Sie die Einstellung ,,Systemstartauswahl® Ihres Computers wieder auf
Normaler Systemstart - Alle Geréatetreiber und Dienste laden. Sie konnen die Systemstartelemente
und weniger wichtige Vorgidnge auch manuell deaktivieren.

Anfertigen von Sicherheitskopien

Nach der Konfiguration Ihres Systems und der Installation von Pro Tools sollten Sie mit einem
Backup-Programm ein Image des Systems erstellen. Auf diese Weise kénnen Sie die System-
konfiguration und -einstellungen bei Problemen schnell wiederherstellen.
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Instalacion del software Pro Tools

Te damos la bienvenida a Pro Tools® de Avid. En esta guia se explican los procesos de instalacion
y autorizacidn del software Pro Tools en sistemas Mac y Windows. Para obtener informacién
detallada sobre como configurar tu sistema Pro Tools e informacién completa sobre sus
posibilidades, caracteristicas y funciones, consulta la Guia de referencia de Pro Tools (disponible
en el ment Help de Pro Tools).

Hay tres tipos de sistemas Pro Tools:

Software Pro Tools

Estos sistemas incluyen software Pro Tools con interfaces de audio de las familias 003® o
Digi 002™; Eleven®Rack, Mbox®, Mbox 2 o hardware de M-Audio. El software Pro Tools también
puede usarse con interfaces de audio de otros fabricantes compatibles con drivers Core Audio
(Mac, incluido el audio incorporado) o ASIO (Windows).

Software Pro Tools HD con aceleracion por hardware

Estos sistemas Pro Tools HD acelerados por hardware vienen con el programa Pro Tools HD
y hardware Avid HDX, Pro Tools|HD o HD Native. Los sistemas acelerados por hardware ofrecen
funciones de E/S ampliadas y monitorizacion de baja latencia. El software Pro Tools HD con
hardware Avid HDX o Pro Tools|HD también proporciona procesadores DSP dedicados para
procesar plug-ins y para configuraciones de mezcla grandes.

Software Pro Tools HD o Pro Tools con Complete Production Toolkit

Estos sistemas incluyen el programa Pro Tools HD o el programa Pro Tools, mas la opcién
Complete Production Toolkit, con cualquier equipo compatible con Avid, Core Audio o ASIO.

Software Pro Tools Express

Estos sistemas incluyen el programa Pro Tools Express con interfaces de audio de la familia
Mbox (3.® generacion). Para obtener mds informacion, consulta la Guia de instalacién de
Pro Tools Express.

\Q’ Para obtener una lista de ordenadores e interfaces de audio homologados para todos los
= sistemas Pro Tools, visita www.avid.com/compatibility.
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Requisitos y compatibilidad del sistema

Pro Tools se puede utilizar con un interface de audio homologado en un equipo con Windows
0 Mac también debidamente homologado.

Se requiere una unidad DVD para el disco de instalacion de Pro Tools.

Se requiere una conexion a Internet para descargar el instalador de Pro Tools.

Avid solo puede asegurar la compatibilidad y proporcionar asistencia relativa al hardware y
al software probado y homologado por Avid.

Para ver listas completas de requisitos de sistema, ordenadores admitidos, sistemas operativos,
discos duros y dispositivos de otros fabricantes, visita:

www.avid.com/compatibility

Llave iLok autorizada

El paquete de software Pro Tools estandar incluye una llave iLok previamente autorizada para
ejecutar el software Pro Tools. Los paquetes de hardware incluyen una llave iLok todavia sin
autorizar y un cédigo de activacion para la autorizacion de Pro Tools. Para mds informacidn,
consulta “Autorizacién de Pro Tools” en la pagina 78.

A Para poder usar Pro Tools, hay que insertar una llave iLok autorizada en un puerto USB
del ordenador.

Requisitos de MIDI

Los interfaces MIDI USB, FireWire y PCI funcionan correctamente con sistemas Pro Tools en
equipos Mac o Windows. Los interfaces MIDI serie solo son compatibles con los sistemas Windows.

Para ver una lista de interfaces y controladores MIDI admitidos, visita www.avid.com.
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Requisitos de disco duro

Para grabar y reproducir audio de forma 6ptima, los sistemas Pro Tools requieren uno o varios
discos duros homologados.

Inicializa tus discos duros con la Utilidad de disco incluida en los sistemas Apple (Mac) o la
herramienta Administracién de discos de Windows.

Procura no grabar en la unidad del sistema
Es posible grabar en la unidad del sistema, aunque no se recomienda. Grabar y reproducir en
la unidad del sistema puede disminuir el nimero de pistas y de plug-ins que pueden
utilizarse.
‘C)" Para un rendimiento éptimo, es posible que desees designar la unidad del sistema como
volumen de solo reproduccién o solo transferencia en DigiBase. Para obtener mds informacion,
consulta la Guia de referencia de Pro Tools.
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Autorizacion de Pro Tools

El software Pro Tools se autoriza con una llave iLok USB Smart Key (iLok) de PACE Anti-Piracy.
Una de estas llaves puede contener cientos de autorizaciones para todo el software que utiliza
iLok. Una vez se haya autorizado la llave para un determinado programa, puedes utilizarla
para autorizar dicho software en cualquier ordenador.

Llave iLok USB

(L
Q Se puede usar la nueva versién de iLok (mostrada arriba) o la version previa para guardar
®  tus autorizaciones de Pro Tools.

Autorizacion de Pro Tools HD

Una autorizacion de Pro Tools HD permite ejecutar Pro Tools HD en un ordenador Mac o Windows
compatible con o sin hardware Avid HDX, Pro Tools|HD o HD Native. Una autorizacién de
Pro Tools HD permite ejecutar este programa en cualquier interface de audio homologado
por Avid (como Mbox Pro o Fast Track) o cualquier interface de audio de otro fabricante con
drivers de dispositivo Core Audio (Mac) o ASIO (Windows).
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Autorizacion de Pro Tools

Una autorizacién de Pro Tools permite ejecutar Pro Tools en un ordenador compatible Mac o
Windows con un interface de audio homologado por Avid (como Mbox Pro o Fast Track) o
cualquier interface de audio de otro fabricante con drivers de dispositivo Core Audio (Mac)
0 ASIO (Windows).

A Una autorizacién de Pro Tools es insuficiente para ejecutar el programa Pro Tools HD. Si
se intenta ejecutar Pro Tools en un sistema con HDX, Pro Tools|HD o HD Native sin una
autorizacién de Pro Tools HD, el programa se iniciard si puede usar Core Audio o ASIO
con el interface de audio integrado u otro, pero no podrd usar el hardware HDX, Pro Tools|HD
o HD Native.

Autorizacion de Complete Production Toolkit

Una autorizacion de Complete Production Toolkit junto con una autorizacién de Pro Tools
permiten ejecutar Pro Tools con las capacidades del Complete Production Toolkit. La opciéon
Complete Production Toolkit proporciona una mayor cantidad de voces y pistas, asi como
funciones de mezcla, edicion y automatizacién surround, equivalentes a las de Pro Tools HD.

Para obtener mds informacién sobre la opcidn de software Complete Production Toolkit,
consulta la guia de Complete Production Toolkit o la Guia de referencia de Pro Tools.

Autorizacion de llave iLok con un cédigo de activacion

Si has comprado una nueva version en caja de Pro Tools, dicha version viene con una llave iLok
preautorizada. Puedes omitir esta seccion y seguir con “Instalacién de Pro Tools” en la
pagina 80.

Si compraste un nuevo sistema Avid HDX, Pro Tools|HD o HD Native, este se entrega con una
llave iLok vacia y un cddigo (en la tarjeta de activacién que se incluye) para autorizar el programa
Pro Tools HD. Sigue las instrucciones a continuacién.
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Sihas actualizado una version anterior de Pro Tools, la autorizacion se entrega con un cédigo
(en la tarjeta de activacion incluida) para autorizar la actualizacion del software en la llave
iLok. Sigue las instrucciones a continuacién.
Para autorizar el software Pro Tools mediante un cédigo de autorizacion:
1Si no tienes una cuenta de iLok.com, visita www.iLok.com y crea una cuenta.
2 Transfiere la licencia de tu software a la cuenta de iLok.com de la siguiente manera:
» Visita www.avid.com/activationcard.
-y-
« Introduce el cddigo (que aparece en la tarjeta de activacién) y el ID de usuario de iLok.com.
E1 ID de usuario es el nombre que creas para la cuenta de iLok.com.
3 Transfiere las licencias de tu cuenta de iLok.com a tu USB Smart Key siguiendo estos pasos:
« Inserta la llave iLok en un puerto USB disponible del ordenador.
» Ve a www.iLok.com e inicia sesidn.

« Sigue las instrucciones en pantalla para transferir las licencias a tu llave iLok.

Para obtener mds informacién, visita la pdgina web de iLok (www.iLok.com).

Instalacion de Pro Tools

A Si estds actualizando Pro Tools, asegiirate de desinstalar cualquier version anterior del
programa. Consulta “Desinstalacién de Pro Tools” en la pdgina 89.

Descripcion general de la instalacion
La instalacion de Pro Tools implica los pasos siguientes:

1 “Instalacién de drivers de hardware” en la pagina 81.
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2 “Instalacion del software Pro Tools” en la pdgina 81.
3 “Instalacion de instrumentos virtuales de Avid” en la pagina 85 (optativo).
4 “Inicio de Pro Tools” en la pagina 87.

5 Configuracion del sistema para obtener un rendimiento mejorado (consulta la Guia de
referencia de Pro Tools).

6 Establecimiento de las conexiones de audio con el interface de audio. (Consulta la documentaciéon
que se entrega con el interface de audio).

Instalacion de drivers de hardware

Antes de instalar el software Pro Tools, cercidrate de tener instalados el hardware de audio y los
drivers mds recientes para el mismo. Consulta la documentacion del hardware para obtener mas
informacidn. Para los interfaces de audio Avid, instala los drivers para el hardware mediante
el instalador correspondiente en el disco de instalacion de drivers que se incluye en el paquete
de instalacién de Pro Tools, o visita www.avid.com/es/drivers para descargar e instalar los
drivers mds recientes para tu dispositivo.

\Q’ En los sistemas con hardware Avid HDX, Pro Tools|HD y HD Native, el instalador de Pro Tools
instala automdticamente los drivers de hardware necesarios.
A Pro Tools no reconocerd tu interface de audio si no instalas los drivers. Si estds actualizando

Pro Tools, asegiirate de instalar los drivers mds recientes para tu hardware.

Instalacion del software Pro Tools

Cuando hayas instalado los drivers para tu interface de audio, podras instalar Pro Tools.

A Antes de instalar esta version de Pro Tools, consulta los documentos Read Me que se incluyen.
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Para instalar Pro Tools:
1Inicia sesién como administrador en la cuenta donde desees instalar Pro Tools.
2 Lleva a cabo uno de estos procedimientos:
o Inserta el disco de instalacién de Pro Tools en la unidad de DVD.
- o bien -
« Descarga a través de Internet el instalador de Pro Tools.
3 Lleva a cabo uno de estos procedimientos:
« En un ordenador Mac, busca y haz doble clic en Install Pro Tools.mpkg.
« En Windows, realiza una de estas acciones:
o Siestd activadala opcion Ejecucion automatica de Windows, aparecera un pequeiio explorador.
Selecciona Install Pro Tools para iniciar la instalacién.
- o bien -
« Si esta deshabilitada la Ejecucion automatica de Windows, haz doble clic en Setup.exe y
selecciona Install Pro Tools para iniciar la instalacion.

A En Windows, si se abre el cuadro de didlogo Control de cuentas de usuario, haz clic en
Permitir. Aparecerdn varios mensajes durante la instalacion que se pueden omitir, como
varios cuadros de didlogo sobre hardware nuevo encontrado y sobre problemas durante la
instalacién del hardware. Si aparece un cuadro de didlogo que indica que el driver no
supera la prueba del logotipo de Windows, contintia de todos modos.

4 Sigue las instrucciones en pantalla para continuar con la instalacién.
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5 En la pagina Installation Type, realiza una de las siguientes acciones:

« Para instalar todos los archivos de la aplicacién Pro Tools y las suites de plug-ins gratuitas
(junto con el contenido asociado), deja seleccionadas las opciones de instalacion predeterminadas
y haz clic en Continue.
- o bien -

« Selecciona las opciones de instalacion que desees o anula la seleccion de las que no desees
(consulta “Opciones de instalacién” en la pagina 83) y haz clic en Continue.

6 Haz clic en Install.

7 Si se te solicita, introduce tu contrasefia de administrador y haz clic en Aceptar para autorizar

la instalacion.

8 Sigue las instrucciones en pantalla.

9 Una vez completada la instalacion, haz clic en Restart (Mac) o Finish (Windows).

\Q’ El disco de instalacion de Pro Tools incluye software adicional para el sistema. Para mds
© informacidn, consulta “Software adicional en el disco de instalacién de Pro Tools” en la
pdgina 88.

Opciones de instalacion

Opciones de Pro Tools 10

Para instalar solo un subconjunto de plug-ins y software Pro Tools, haz clic en el tridngulo que
aparece junto a la opcion Pro Tools 10 en el instalador y deselecciona cualquiera de las siguientes
opciones que no desees instalar.

Application Files (necesarios para Pro Tools) Instala la aplicacion Pro Tools y los archivos de
libreria necesarios para ejecutar Pro Tools. Esta opcion debe estar seleccionada para instalar
Pro Tools.

Avid Effects Instala los plug-ins de efectos de audio de Avid. Para obtener mas informacion,
consulta la Guia de plug-ins de audio.

Pro Tools Utilities Instala utilidades de Pro Tools, como DigiTest y Uninstall Pro Tools (solo Mac).
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Additional Options

El instalador de Pro Tools proporciona las siguientes opciones adicionales, que se pueden
instalar junto con los plug-ins y el software Pro Tools.

Opcion Mac HFS+ Disk Support (solo Windows) Esta opcidn permite leer, escribir, grabar y reproducir
material en discos con formato HFS+ de Mac en el sistema Pro Tools. Los discos HFS+ se suelen
llamar discos extendidos de Mac OS. Para obtener mas informacion, consulta la Guia de referencia
de Pro Tools.

Avid Video Engine Avid Video Engine es necesario para utilizar Pro Tools con periféricos de
video de Avid, como Avid Mojo® SDI. Si necesitas més informacién, consulta la Guia de periféricos
de video de Avid.

Encendido y apagado del sistema

Para que haya una correcta comunicacion entre los componentes del sistema Pro Tools, es
preciso seguir un orden de inicio concreto.

Inicia el sistema Pro Tools en este orden:

1 Asegurate de que todos los componentes (incluido el ordenador) estén apagados.

2 Baja el volumen de todos los dispositivos de salida del sistema.

3 En los sistemas con un chasis de expansion, enciende primero el chasis.

4 Enciende los discos duros externos. Espera diez segundos para que alcancen la velocidad de
funcionamiento.

5Enciende las superficies de control.
6 Enciende los interfaces y los dispositivos MIDI, o los periféricos de sincronizacidn.

7 En el caso de sistemas que necesitan alimentacién externa, enciende el equipo (por ejemplo,
HD I/0 0 003). Espera al menos quince segundos para que el interface de audio se inicie y los
indicadores LED de estado dejen de parpadear.

8 Enciende el ordenador.
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9 Inicia Pro Tools (consulta “Inicio de Pro Tools” en la pagina 87) o cualquier aplicacién
MIDI o de audio de otros fabricantes.

Apaga el sistema Pro Tools en este orden:
1 Cierra Pro Tools y las demds aplicaciones que estén en uso.

Para salir de Pro Tools, selecciona Pro Tools » Quit (Mac) o File » Exit (Windows).

2 Apaga o baja el volumen de todos los dispositivos de salida del sistema.

3 Apaga el ordenador.

4 En los sistemas con hardware que requiere alimentacion externa, apaga el hardware.
5 Apaga los interfaces de audio de Pro Tools.

6 En los sistemas con un chasis de expansion, apaga el chasis.

7 Apaga los interfaces y los dispositivos MIDI, o los periféricos de sincronizacion.

8 Apaga cualquier superficie de control o de trabajo.

9 Apaga los discos duros externos.

Instalacion de instrumentos virtuales de Avid

Avid ofrece un conjunto de plug-ins de Instrumentos virtuales gratuitos relacionados con
contenido de samples para utilizar con Pro Tools. Para obtener mas informacién, consulta la
Guia de plug-ins de audio.

Para instalar los instrumentos virtuales de Avid:

1 Inicia sesion como administrador en la cuenta donde desees instalar los instrumentos virtuales
de Avid.

2 Lleva a cabo uno de estos procedimientos:
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« Inserta el disco de instalacion de Pro Tools en la unidad de DVD.
- o bien -

«+ Descarga a través de Internet el instalador de los instrumentos virtuales de Avid y el contenido
relacionado.

3 Lleva a cabo uno de estos procedimientos:
« En un equipo Mac, busca y haz doble clic en Install Avid Virtual Instruments.mpkg.
« En Windows, realiza una de estas acciones:

« Al instalar desde el disco, si esta activada la opcidn Ejecucion automatica de Windows,
aparecerd un pequeno explorador. Selecciona Install Avid Virtual Instruments para iniciar la
instalacion.

« Alinstalar desde el disco, si estd desactivada la opcion Ejecucion automatica de Windows,
haz doble clic en Setup.exe y luego selecciona Install Avid Virtual Instruments para comenzar
la instalacion.

« Site descargaste el instalador de Instrumentos virtuales de Avid, ejecuta Avid Virtual
Instruments.exe.

4 Sigue las instrucciones en pantalla para continuar con la instalacién.

5 Haz clic en Install.

A El contenido de los instrumentos virtuales es muy amplio, y su instalacién puede llevar
hasta 20 minutos. Durante este tiempo, es posible que parezca que la barra de progreso no
se mueve, pero el software seguird instaldndose. No canceles la instalacién.

6 Si se te solicita, introduce tu contrasena de administrador y haz clic en OK para autorizar la
instalacién.

7 Sigue las instrucciones en pantalla.

8 Una vez completada la instalacion, haz clic en Close (Mac) o Finish (Windows).
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Inicio de Pro Tools

Para usar el software Pro Tools, se debe tener una llave iLok con una licencia que autorice la
version de Pro Tools instalada (para obtener mds informacion, consulta “Autorizacion de
Pro Tools” en la pagina 78).

Para iniciar el software Pro Tools:

1 Comprueba que el interface de audio esté conectado al ordenador y encendido.

2 Inserta una llave iLok autorizada en cualquier puerto USB del ordenador que esté disponible
(consulta “Autorizacién de Pro Tools” en la pagina 78).

A Durante el inicio o la utilizacién de Pro Tools, no retires la llave iLok.

3 Lleva a cabo uno de estos procedimientos:

« En Mag, haz clic en el acceso directo de Pro Tools en el Dock (o haz doble clic en el icono de
la aplicacién en Macintosh HD/Applications/Avid/Pro Tools).

- 0 bien -

« En Windows, haz doble clic en el acceso directo a Pro Tools en el escritorio (o en la aplicaciéon
en Archivos de programa\Avid\Pro Tools).

4 Utiliza el cuadro de dialogo Quick Start para:
« Crear una sesién a partir de una plantilla.
« Crear una sesion en blanco.

o Abrir cualquier otra sesion que se encuentre en el sistema.

Para obtener mds informacién sobre el cuadro de didlogo Quick Start y las plantillas de
sesién, consulta la guia de referencia de Pro Tools.
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Configuracion del sistema Pro Tools

Cuando hayas instalado, autorizado e iniciado el software Pro Tools, podras configurar el sistema
Pro Tools segun las necesidades especificas de tu estudio. Para obtener més informacion sobre
la configuracién del software Pro Tools, consulta la Guia de referencia de Pro Tools (disponible
en el menu Help de Pro Tools).

Software adicional en el disco de instalacion de Pro Tools

El disco de instalacién de Pro Tools incluye documentacién y software adicionales para el
sistema Pro Tools en la carpeta Additional Files.

Documentation

La carpeta Documentation contiene documentacion en formato PDF para el software, hardware,
los plug-ins y las opciones de Pro Tools.

Tech Support

La carpeta Tech Support contiene documentacién en formato PDF, informacién sobre recursos
online y sesiones de Pro Tools para solucionar problemas con el sistema Pro Tools.

Optional Installers

La carpeta Optional Installers contiene instaladores para opciones de software de Pro Tools
que se pueden adquirir y autorizar por separado.

HEAT

(solo sistemas Avid HDX y Pro Tools|HD)

HEAT (Harmonically Enhanced Algorithm Technology) es una opcién de software de pago que
afiade “personalidad analégica” a los sistemas Avid HDX y Pro Tools|HD. Para mas informacion,
consulta la Guia de la opcion de software HEAT.
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Sesion de demostracion de Pro Tools
El disco de instalacién de Pro Tools HD incluye una sesién de demostracion que puedes utilizar
para comprobar el buen funcionamiento del sistema.

Para instalar la sesiéon de demostracion:

1Inserta el disco de instalacién de Pro Tools en la unidad de DVD.

2 En el disco de instalacion de Pro Tools, busca y abre la carpeta Additional Files.
3 Copia la carpeta Pro Tools Demo Session a una unidad de audio vélida.

4 Abre la sesion de demostracidn.

Desinstalacion de Pro Tools

Sinecesitas desinstalar el programa Pro Tools del ordenador, utiliza la aplicacién de desinstalacion
en Mac, o el Panel de control (Programas) en Windows.

Desinstalacion de Pro Tools en Mac

Para desinstalar Pro Tools de un sistema Mac:

1 Asegurate de iniciar sesiéon como administrador en la cuenta en la que esté instalado Pro Tools.
2 Ve a Aplicaciones/Avid/Pro Tools/Pro Tools Utilities y haz doble clic en Uninstall Pro Tools.
3 Haz clic en Continue para proceder a la desinstalacion.

4 Selecciona el tipo de desinstalacion que deseas efectuar:

Safe Uninstall Esta opcion omite la desinstalacion de plug-ins y archivos del sistema que se
necesitan parala compatibilidad con otros productos de Avid. Utiliza la opcién Safe Uninstall
si usas una aplicacion Avid o vas a actualizar a una versién de soporte de cliente.

Instalacion del software Pro Tools 89



Clean Uninstall Esta opcion elimina todos los archivos de Pro Tools, incluidos los archivos del
sistema, plug-ins de Avid y nombres de patches MIDI. Utiliza la opcién Clean Uninstall si estds
preparando el sistema para una actualizacion o si quieres solucionar problemas a partir de un
sistema limpio.

5 Haz clic en Uninstall.
6 Introduce la contrasefia de administrador y haz clic en OK.

7 Haz clic en Finish para cerrar la ventana del instalador.

Desinstalacion de Pro Tools en sistemas Windows
Para desinstalar Pro Tools en Windows:

1 Elige Inicio > Panel de control.

2 Haz clic enProgramas y caracteristicas.

3 Haz clic en Desinstalar un programa.

4 Selecciona Avid Pro Tools de la lista de aplicaciones instaladas.

5 Haz clic en Desinstalar.

6 Sigue las instrucciones en pantalla para eliminar el programa.

Q Ten en cuenta que deberds desinstalar los plug-ins (como los efectos de Avid), asi como todos
" los drivers de dispositivos MIDI y de audio, por separado.
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Optimizacion de un sistema Mac para Pro Tools

Para garantizar el 6ptimo funcionamiento con Pro Tools, antes de usar el software Pro Tools,
configura el ordenador.

Antes de configurar el ordenador, inicia sesién como administrador en la cuenta donde desees
instalar Pro Tools. Para obtener informacion sobre los privilegios de administrador en Mac OS X,
consulta la documentacién de Apple OS X.

A No utilices la funcion de actualizacién automdtica del software de Mac 0S X, ya que podria
actualizar el sistema con una version de Mac OS que aiin no se haya homologado para
Pro Tools. Para obtener informacién sobre versiones homologadas de Mac OS, consulta la
informacion de compatibilidad actualizada de nuestra pdgina web (www.avid.com).

Desactivacion de la actualizacion de software
Para desactivar la funcion de actualizacion de software:

1 Elige Preferencias del Sistema en el menu Apple.

2 Haz clic en Actualizacion de Software.

3 Haz clic en la pestafia Busquedas programadas.

4 Anula la seleccion de Buscar actualizaciones.

5 Al finalizar, selecciona Preferencias del Sistema > Salir de Preferencias del Sistema.
Desactivacion del economizador

Para desactivar la funcion de economizador:

1 Elige Preferencias del Sistema en el menu Apple.

2 Haz clic en Economizador.

3 Configura la opcion Reposo del ordenador en Nunca.

4 Configura la opcién Reposo del ordenador en Nunca.
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5 Anula la seleccién de la opcidn Poner el disco en reposo cuando sea posible.

6 Al finalizar, selecciona Preferencias del Sistema > Salir de Preferencias del Sistema.
Desactivacion o reasignacion de los atajos de teclado de Mac que se utilizan
en Pro Tools

Para poder utilizar todos los métodos abreviados de teclado de Pro Tools, debes desactivar o
reasignar en las preferencias del sistema de Apple los métodos abreviados de teclado de Mac
0S X que entren en conflicto con el software.

Para ver una lista completa de los métodos abreviados de teclado de Pro Tools, consulta
la Guia de métodos abreviados de teclado (Help > Keyboard Shortcuts).

Desactivacion o reasignacion de los métodos abreviados de teclado que se utilizan en Pro Tools
(Mac OS X Lion):

1En el menu Apple, selecciona Preferencias del Sistema.

2 Haz clic en Teclado y ratén.

3 Haz clic en la pestafia Funciones rapidas de teclado.

4 Puedes deshabilitar o reasignar los atajos de teclado que entren en conflicto con los de Pro Tools.
La siguiente lista incorpora varios atajos de teclados comunes que, segtin cual sea el modelo
de tu Mac, también pueden ser utilizados por Pro Tools:

« En “Launchpad y Dock”

« “Ocultar y mostrar el Dock automaticamente”
« En “Mission Control”

o “Mission Control”

» “Ventanas de aplicacién”

o “Mostrar escritorio”

o “Mostrar Dashboard”

« “Mission Control » Mover a la izquierda un espacio”
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» “Mission Control » Mover a la derecha un espacio”
« “Mission Control » Pasar al Escritorio n”
« En “Teclado y entrada de texto”
« “Mover el enfoque al cajon de la ventana”
« En “Servicios”
« “Enviar archivo a dispositivo Bluetooth”
« “Buscar con Google”
« “Spotlight”
« “Buscar paginas man en Terminal”
« En “Spotlight”
o “Mostrar el campo de busqueda de Spotlight”
» “Mostrar la ventana de Spotlight”
« En “Acceso universal”
« “Zoom”
« “Contraste”
« En “Atajos de aplicaciones”
« “Mostrar el menu Ayuda”

Desactivacion o reasignacion de los métodos abreviados de teclado de Mac que se utilizan en Pro Tools
(Mac OS X Snow Leopard):

1En el mentd Apple, selecciona Preferencias del Sistema.
2 Haz clic en Teclado y raton.

3 Haz clic en la pestaiia Funciones répidas de teclado.
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4 Puedes deshabilitar o reasignar los atajos de teclado que entren en conflicto con los de Pro Tools.
Lalista siguiente incluye varios atajos de teclado comunes de Mac que también usa Pro Tools:

« En “Dashboard y Dock”
« “Ocultar y mostrar el Dock automaticamente”
« “Dashboard”
« En “Exposé y Spaces”
« “Todas las ventanas”
« “Ventanas de aplicacién”
« “Escritorio”
« En “Teclado y entrada de texto”
« “Mover el enfoque al cajon de la ventana”
« En “Spotlight”
o “Mostrar el campo de busqueda de Spotlight”
« “Mostrar la ventana de Spotlight”
« En “Atajos de aplicaciones”

« “Mostrar el menu Ayuda”

Desactivacion de los indices de Spotlight

La funcién Spotlight de Mac OS X indexa autométicamente los archivos y carpetas de los discos
duros locales en segundo plano. En la mayoria de los casos, esto no supone un problema para
el uso normal de Pro Tools. Sin embargo, si Spotlight comienza a indexar el contenido de las
unidades de disco mientras se estd grabando en una sesion de Pro Tools con muchas pistas
durante un tiempo prolongado, puede afectar negativamente al rendimiento del sistema Pro Tools.
Si piensas utilizar Pro Tools para proyectos de grabacion de gran tamaiio, es recomendable
desactivar antes la indexacién de las unidades locales de Spotlight.

94 Instalacién del software Pro Tools



A Al desactivar la indexacion de Spotlight también se desactiva la funcion de biisqueda de
Mac 0S X.

Para desactivar la funcion de indexacion de Spotlight:
1 Elige Preferencias del Sistema en el menu Apple y haz clic en Spotlight.
2 En la ventana Spotlight, haz clic en la pestafia Privacidad.

3 Para evitar la indexacidn de una unidad, arrastra su icono del escritorio a la lista.

Activacion del registro para las unidades de audio

Para conseguir un mejor rendimiento con unidades de audio, activa la funcién de registro.
Para activar la funcién de registro:

1Inicia la aplicacién Utilidad de disco, ubicada en Aplicaciones/Utilidades.

2En la columna izquierda de la ventana Utilidad de disco, selecciona el volumen.

3 En la barra de herramientas, selecciona Activar registro.

Optimizacion de un sistema Windows para Pro Tools

Para asegurar un rendimiento dptimo con Pro Tools, configura el ordenador antes de utilizar
el hardware y el software Pro Tools.

Antes de configurar el ordenador, inicia sesién como administrador en la cuenta donde desees
instalar Pro Tools. Para obtener mds informacion al respecto, consulta la documentacién de
Windows.

Para obtener la informacién mds actualizada acerca de la configuracion del sistema de

Windows y para obtener informacién acerca de ordenadores especificos, visita la pdgina
web de Avid (www.avid.com).
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Optimizaciones obligatorias

Para asegurar un rendimiento 6ptimo con Pro Tools, configura los pardmetros siguientes antes
de utilizar el hardware y el software Pro Tools.

A Cuando hayas terminado de cambiar la configuracién del sistema Windows, reinicia el
ordenador.

Desactivacion del Control de cuentas de usuario
Para desactivar el Control de cuentas de usuario:

1 Elige Inicio > Panel de control.

2 Haz clic en Cuentas de usuario y proteccion infantil.

3 Haz clic en Cuentas de usuario.

4 Haz clic en Cambiar configuracién de Control de cuentas de usuario.
5 Coloca el control deslizante en No notificar nunca.

6 Haz clic en Aceptar.

Configuracion de inactividad del sistema y administracion de energia

Cuando utilices Pro Tools, establece la opcion de energia de modo de espera de Windows en
Siempre activo. De este modo, se evita que se detengan los pases de grabacién y reproduccion
prolongados porque el sistema entra en el modo de ahorro de energia.

Para configurar Administracion de energia de Windows:
1 Elige Inicio > Panel de control.

2 Haz clic en Sistema y seguridad.

3 Haz clic en Opciones de energia.

4 Haz clic en la flecha para Mostrar planes adicionales.

5 Selecciona Alto rendimiento.
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6 Haz clic en Cambiar la configuracion del plan.

7 Haz clic en Cambiar la configuracion avanzada de energia.

8 En el cuadro de didlogo Opciones de energia, abre Disco duro > Apagar disco duro tras.
9 Haz clic en la opcidn Configuracion.

10 Selecciona el valor en el campo Configuracién (minutos) y pulsa la tecla Retroceso en el
teclado o lleva el valor a Nunca.

11 Haz clic en Aceptar. La configuracion del disco duro cambia a Nuncay se cierra el cuadro de
didlogo Opciones de energia.

12 En la ventana Editar la configuracién del plan, haz clic en Guardar cambios y cierra la ventana.

A Pro Tools cambia automdticamente a la opcién de administracion de energia “Alto
rendimiento” al iniciarse. Windows regresa a la opcién de administracion de energia
seleccionada anteriormente (si la hubiere) al salir de Pro Tools. Por consiguiente, al optimizar
la opcidn de administracién de energia para Pro Tools, siempre se deberia optimizar
tinicamente la configuracion de Alto rendimiento.

Optimizaciones recomendadas

Otros drivers de hardware y software que estén instalados en el ordenador también pueden afectar
a Pro Tools. Para obtener un rendimiento dptimo, se recomienda (aunque no es imprescindible)
que hagas lo siguiente:

« Evitala ejecucion simultanea de otros programas innecesarios al mismo tiempo que Pro Tools.

« Cierra las utilidades de software que se ejecuten en segundo plano, por ejemplo, Windows
Messenger, calendarios y programas de mantenimiento de discos.

» Mientras utilizas Pro Tools, apaga todos los dispositivos USB que no sean imprescindibles.
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Optimizaciones opcionales

Las siguientes optimizaciones del sistema pueden contribuir a un mejor funcionamiento de
Pro Tools en algunos sistemas. Se recomienda usar estas optimizaciones solamente cuando
sea necesario, ya que pueden desactivar otros programas del sistema o repercutir negativamente
en su funcionamiento.

Ajuste de la programacion del procesador

Para ajustar el rendimiento de la programacion del procesador:

1 Haz clic con el botdn derecho del ratén en Mi PC y selecciona Propiedades.

2 Haz clic en Configuracion avanzada del sistema.

3 En el 4rea Rendimiento, haz clic en el botdn Configuracion.

4 En la ventana Opciones de rendimiento, haz clic en la pestafia Opciones avanzadas.
5En Programacion del procesador, selecciona Servicios en segundo plano.

6 Haz clic en Aceptar para cerrar la ventana Opciones de rendimiento.

7 Haz clic en Aceptar para cerrar la ventana Propiedades del sistema.

Desactivacion de los elementos de inicio del sistema

Cuantos menos elementos utilice el ordenador, mas recursos habra disponibles para Pro Tools.
Algunas aplicaciones que se inician automdticamente al arrancar el sistema pueden estar
consumiendo recursos de la CPU innecesariamente y pueden desactivarse.

Ten cuidado si desactivas alguno de los elementos de inicio siguientes:

« Numero de serie de medio portatil (necesario para algunas aplicaciones que utilizan una
clave de proteccion anticopia)

« Servicio Plug and Play
« Registro de eventos

« Servicios de cifrado
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Para desactivar los elementos de inicio del sistema:

1 En el ment Inicio, escribe “msconfig” en Ejecutar y haz clic en Aceptar para abrir la Utilidad
de configuracion del sistema.

2 En la pestaiia General, elige Inicio selectivo.

3 Anula la seleccién de Cargar elementos de inicio y haz clic en Aceptar.

4 Haz clic en Reiniciar para volver a iniciar el ordenador.

5 Tras reiniciar, el ordenador mostrard un mensaje de configuracioén del sistema. Comprueba
si ha mejorado el rendimiento de Pro Tools antes de anular la seleccién de la casilla “No volver
amostrar este mensaje”. Si no se observa ninguna mejora en el rendimiento, ejecuta “msconfig”
y vuelve a establecer Seleccién de inicio en Inicio normal: cargar todos los controladores de dispositivo
y servicios. También puedes desactivar los elementos de inicio y los procesos que no sean
imprescindibles de uno en uno.

Copias de seguridad del sistema

Tras configurar el sistema e instalar Pro Tools, debes guardar una imagen de la unidad del
sistema con una utilidad de copia de seguridad. De este modo, podras restaurar rapidamente
la configuracién del sistema en caso de producirse algin problema.
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1 Avid Virtual Instruments #4 Y A b — )L g 27 hU v McEHEL LTI A LTS T &
ZhERLET,

2 FOVTFNLZETOET,
o ProTools T YA r—F— 54 X7 %DVD RT 4 TIHALET,
ErdzS
« Avid Virtual Instruments ¥ Y A b —F— Oy F oy 2tr I Zyra—RLET,
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S3UTFOVTNLEITVET,
« Mac Cl&. [Install Avid Virtual Instruments.mpkgl Z%Z 7 )L 7V w7 LEd,
« Windows D&, LFOVWETNLZITNET,
o TARIMEA YA M—)ILT E5E, Windows AutoRun AR THNE, S =T TP —n%k
RENFK T, [nstall Avid Virtual Instruments] Z3ER L TA A b —)L 2L £ T,

o TARIMEA YA M—)ILT 588, Windows AutoRun MR THNIE, [Setup.exel ZX 7
Vw7 LTH 5 [nstall Avid Virtual Instruments] Z3RUTA Y A F—)IL 2B L E T,

Avid Virtual Instruments ¥ > A b —F—7%& & > o— R L5E. [Avid Virtual Instruments.exel
ERITLET,

4 EORRIEME>TA VAL =y a Y ERKETET,

5 [4YZ K= (nstal) 227 Vw7 LXT,

A N—=F )V e A VA YN AY DAY TUIET 7 AN « A XWMIEFICRKEL, 41V
A= VIC20 7 RENIDN B ENBOET, A VA=), EHBN—DEE>TWVB &K
IIHRAZTENDHDFITN, EBICWE A VAP IVEETLTVET, A VA=V %
ByLawTl T,

6 Ay t—IYUMBERRINESL, BHENNZAT—FZANL, [OKl 27Uy 7 LTA YA M—)LEK
RLET,

7 HEiH LOZDMOIERICHENE T,

8 A VAR—IVAR T LIcH, [BU3] (Mac) F7zid (#&T] (Windows) Z7 Vw7 L&Y,
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Pro Tools Z&E8d 3

ProToolsV 7+ = 7 ZMH T 3ICd. A VA F—IVENTWVS Pro Tools D/X— 3 VA —Y
FAALTVETA Y AHD Lok BRHETT (FEL <103 X—TD [Pro Tools 24—V T4
X% ZTBMITEEI W),

Pro Tools V7 b 1 7 =EETBICIS :

14 —FT 44 AV EZ—=T 2 AANAVE 2 —Z—ICHEFHINTED ., BENMA>TVB T L &R
LET,

24—V I A4 RXENiLokZ A ¥ 2 —X—DUSBR— % LiAFHFE (103 X—T DI Pro Tools
BA=VSA4XT5] BR),

A\ Pro Tools DB E 72 (5 HIC Lok 2D A E BT EE L,

3UTOVTF NN ZEITVET,

o Mac D&, Dock® [Pro Tools] ¥a—hAhw b&EZ Uy LET (Fik. [Macintosh HD] /
[7 7V r—>a>]/[Avid]/[Pro Toolsl D7 TV r—>a > 74z ZT)V I )y 7 LET),
E?S

« Windows D&, 7AZ kv 7D [Pro Tools] ¥a—FAv b (F7zi&. [Program Files] \
[Avid] \ [Pro Tools] 7 FUr—>a>y - 77 A4)N) ZEXTLVI VY I LET,

4714wy AZ2—F] A7 2l TUROVWTNAHZITVET,

e TYTL—FhoHHty v a Y RIERT S,

ZEOH R Yy ¥ a Y EEKRT %,

« VAT LICHBMOEYy > a L,

(A4v s RE—R X477ty rar07YTL— POV THLLRE,
[Pro Tools V7 7 LY X « 4 Kl ZTHBWIIZE W,
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Pro Tools VAT LZEHET S

Pro Tools V7 h I 27 DA VA=)V, =V AR, LENRET LIS, THADPro Tools
VAT LEAZIADZ— R EDE TR ETEE T, Pro Tools V7 b7 = 7 DIESTIEICDNT
#EL <&, TPro Tools V7 7 LY A « #A FJ (Pro Tools ® [NVT] XAZa—) ZTHBHIEZE W,

;roTTools4’JZ P=S= e FLAIRPFENTVBENY I
T

Pro Tools 1 Y A b—F— « F 4 ZAZIc kD, THiFD Pro Tools ¥ A7 LHIDEMFHHAFHF &Y 7 b
v = 77/ [Additional Files] 7 A )V X —IcA Y A b —)VENET,

RFaXYF—v3Yy

[Documentation] 7 # /WX —Ici&, Pro Tools V7 by 7 . N—RY 7, IS5 A4 4T3
VICHT BHIIHEOPDEMATENTVET,

FOZAI s BiKR—-b

[Tech Support] 7 # )L & —ICi&. Pro Tools ¥ AT LD b T 7)o —F 1 ¥ F H OFIHED PDF kK.
FVIA4Y - Y —RXEH. ProToolsty ¥ arBEEhTunkd,

FT3VDAL VA N—=5—

[Optional Installers] 7 # /)L X —iCl&. Pro ToolsY 7 bD 7 «+ AT a VHDOA VA L —F—=h
AENTHED, JIRWBALTA—YIARATEET,

HEAT
(Avid HDX 8 & U Pro Tools|HD ¥ X5 LD )

HEAT (Harmonically Enhanced Algorithm Technology) @ H#EY 7 +v =7 « S 3 v T,
Pro Tools HDX # & U Pro Tools|HD & 27 L% f#i ] L 7z Pro Tools HDIC 7)1 J ] ZiBiT
EE T, HEATICDWCFEL &, THEATY 7 vV =7 - AT a v - A Pl 2T T,
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Pro ToolsFE - EvyaYy

Pro Tools f Y AR —F—« T4 AZICRETE -y yaryPlEESh T, YATFTLHIELLH
ELTW B0 EI D EERTZ LN TEEXT,

FE-EYYIVESIAMIWTBICE:

1Pro Tools f YA r—F—+ 74 A7 %ZDVD FSATICHALET,

2 Pro Tools ¥ Y A b —F— - 7+ A7 ® [Additional Files] 7+ /WX —%ZHE %7,

3 [Pro Tools Demo Session] 7 # VX —7%jib)ixt—7 44 « RS 4 71ca—LET,

457F -y yaryEHEET,

Pro ToolsZ7 A4 VA M=ILT D

AV a—X—h5ProTools V7 7 = 7 ZHIkRd % 68 % % . Mac Tl [Uninstaller] 77
Y4 — g%, Windows T3 [T ba—b8xL] Z2EALET,

Mac CPro ToolsE7 A4 A M=ILTD

Mac TPro Tools €7 VA4 VA M=ILFBICIE :

1 Pro Tools A YA R —)LENTWAT AT Y MIEHEZEL LTI AV LTWVWAH T L ZMERLE T,
2[7 7V —a>]/ [Avid] / [Pro Tools] / [Pro Tools Utilities] & H L. [Uninstall Pro Tools]
XTIV I LET,

3 [I+%] (Continue) ZZ7 Vw7 LTT YA VA M=)V EKFIET,

QETTET VA VAN DRA THBEIRLET,

[t—7 742V Z b=IV] (Safe Uninstall) —0D Avid &5 & O Bk O #ERHC 8 & 752 % R
DTFGTAVEVATL T 7 ANVEKRLET, Avid7 7V =2 a VEBHL TV RHERCS
BAEI— P R—=F) VU—RCT7 v T T—= T35, [L—T7 7VA YA b—)l] Z#ER
LET,

[DU=2 742X b=)L] (Clean Uninstall) > A5 L+ 7 7 A )b, Avid 75 7« >, MIDI
Ny FHIZE, TRXTDPro Tools 7 7 AIIVEHIBRLES, 7y 7 I L—RZITIHER NI T
Va—T a4 VT ERGIGER. [FV—=Y T UA YA M=)V] BFEIRLTLEI D,
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5 [PV YZK=)U] (Uninstall) Z27 Vw7 LET,
6 EHH AT —RKZANL, [OKl 27V v I LET,
7 %71 (Finish) Z27 )y 2L, A YAb=5—DOU 4 Y RUZHLET,

Windows CTPro Tools Z7 V1A M=IVTD

Windows TPro Tools 27 VA VA M—=ILTBICII :

1 [25—K > [AvbO—L ARV ZRIRLET,

2 [(JOJSLEHEE 27V v I LT,

3 [TOISLDOFIAVAR=I] VU Yy 7 LET,

QA VA=)V ENTWBRT7 TV —a3>D) A5 [Avid Pro Tools] ZFERLEF T,
5[PVAVAR=I] 27Uy I LET,

6 i D F5/RICHE> T, Pro Tools ZHIPRL 9,

G 75542 (Avid Bffects % &), BEVUA—F 14 L MIDIOF /51 R+ K54 53— 3 ik
T YA VANV BRENB D T
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Pro Tools[cHUTMac YAFLERB(ILTS
Pro Tools TIEHD /ST 4+ —<X YV AZGOENE KT R FTAVEa—2—DREEITVET,

AV 2 —Z—%FET B0, Pro ToolsHA Y A b—)VF 27 hHY Y McEHELLTRT AV
LT3 ezl LT ZE W, Mac OS X DEHEHERICOWVWTH L IE. Apple 0S X DA
He M EE W,

A Mac0SXOEBY T 2T 7 T F— MR LAV T EE L, Ty T
K&k b, MDY AT b Pro Tools D EAf 27z T 72 Mac 0S D/N—=T 3 Y A\ET v
TL—RENTLESHAND O 9. B 2729 Mac 0S D/3—T 3 VIZDWTEEL
. ¥t ow = 794 b OO HHEHR (www.avid.com) ZTE T,

VYINIIT « PYITF—MEFTICTS

VYIMUI7 « Py IF— MEREZZTICTBIC :

1 Apple A =2 —05 [VAFLERERE] ZERLET,

2 [VINYIFPPYIF—N 22UV v I LET,

3 [PyIF—MERETHRE] X T2V v I LET,

4 [7vI7—homR] OFERZMBELE T,

SRUEMNTE Y LIe b, [VATLRERE] > [VATLREREERT] ZHEINLE T,

[EIRIF-] ZFTICTSD

[EIRIVF—] EEEZEFTICTBICII :

1 Apple A =2 —05 [YRFLBERE] ZERLET,

2 [BIRLE-] ZIV YT LET,

3 [OvE2—5DRU—T] &iEZ [LEW ICLET,

4 [F4RTVADRU—T] &EZ LBV IZ LT,

5 [AREEIREIRN\— RT A ROBRU—T&E2] 4 TV a VORREMBELET,

6 HENE T LD, [VATLEBERE] > [YRFLABREREERLT] ZREINLET,
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Pro Toolshi{EAT3MacDF—iK— Ry a—pMhy MEEANICTSHBEEDLETTS

Pro Tools DF —R—F « ¥ a—brAw bZIXNTHEHTZICE, I3>7VU 7 M2 d Mac 0S X
DF—R—F -+ va—rhv % Apple D [V AT LEEHRE] TEMNCTZ20HEHND Y TT B0
BWRHOET,

Pro Tools DF —H— K + &5 — hJy9 F DR A MW TR, [F—K— K+ &3 —
FA b ALK (AVT] > [FmFim Ky a— kg ) £CBECEEW,

Pro Tools CEATd Mac¥—K—R - ¥a—bhy FEEANICTIHESDEHTITSICIE
(Mac OS X Lion) :

1 [Apple] A=a—»5 [YRFLEESRE] ZHRIRLET,
2 [F—HK—Rl ZBZ Vv I LET,
3 [F—R—Rya—tAv k] XTIV I LET,
4 Pro Tools ¥—KR—FK - >a—brhwbearyIU s eI MacOSOF—K—F ¥ 3—F
1y MEEMNICT 20 HEIO Y TTEET, LUFIC, Mac DR & EF)VIC & 5 Tld Pro Tools F—
R=—F-ya—thyreary7U 7+ Z2ECTAREREDOD S MacDF—HKR—F - a—rhv b
ZRLULET,
« [Launchpad & Dock] OF
« [DockZz H BRI ¥RED A Y]]
« [Mission Control] ®F
« [Mission Control]
s [TTV—varvou v RY]
o [FARI by T RER]
« [Dashboard % /K]
« [Mission Control] > [/£DHfEAR— I E)]
« [Mission Control] > [ D#fEAR—ZICHH)]
« [Mission Control] > [FAZ kw7 nAglo#z]
o [F=R—FEeXFAN] OF
o (DAY RYOFEHULSIIVEBRENRICT S]
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o [P—EZ] OF
« [Bluetooth /N1 AT 7 7 1 )L & 3%1(F]
+ [Google THi#]
« [Spotlight]
o [manX—T% 2 —3IF )V THHE]
« [Spotlight] ®F
« [Spotlight #8287 .+ —)U K &2 £ R]
« [Spotlight 7 ¢+ >~ FU 2 &/R]
o [ZZN=Y T TER] OF
o [HER Hii/N]
e [AYEFFRL]
s [7FVr—vav] OF
o [NVTAZa—%FR]
Pro Tools TfEAY S Mac ¥—HK—FK « Ya—bhy MeERICTHDBEEDEHTITSICIE
(Mac OS X Snow Leopard) :
1 [Apple] A=a—05 [YRAFTLBESRFE] Z#ERLET,
2 [F—k—KRl 27Uy 7 LET,
3 [F—R—Rya—bhv N 2727V v I LET,
4 Pro Tools¥—KR—F->¥a—tAhvbearyIU s +rEKRIT MacOSOF—K—F - a—F
Ay MEENCT BN HEE O M T TEE T, LUFIC, Pro Tools+—R—FK - ¥a—rhvwheav
TV b EITAREEDNSH D MacF—F—F - a—thy FERLET,
« [Dashboard & Dock] ®F
« [Dock 7z HBINICER T HERED A /Y]]
« [Dashboard]
« [Exposé & Spaces] OF
o [TRTOY 4 FY]
o [TTV—varvoy s Y]
o [FRI b T]
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o [FR=FexxFAN] OF

o [UYAYRYDFIEH ULV ERENRICT S ]
« [Spotlight] ®F

o [Spotlight #8157 .t —)U F &2 £/R]

« [SpotlightV + ~ FU 2 &/R]
c [TV —vav] OF

o [NVTRARZ 2 —%FR]

Spotlight DFBII &2 T1CFS

Mac 0S X ® Spotlight BREIX, B—AN « RIS T EDOT 7 A )T ANV A=K ZF T E T,
TNy 77T RTHBMNCITbhE T, LA LDEE. TNH Pro Tools DFIFICH L T
MEEEZTLBHDEEA, L. bT v ITHDL U Pro Tools ty > a Y ERKHLI—T ¢ >
Z L TW5 L EIC Spotlight B F 54 T DK IUT I 24 % &, Pro Tools & A7 LOYLIHE S I
WBEG A DABEMENSH D T, Pro Tools Zfli> TR AL I—T 1+ VI TS LEWE, n—Ah
WDFTRTDRT A TIHT % Spotlight DREIF I ZA TICL THLIAFBEVTLE S,

A Spotlight DI EF 71295 L. Mac 0S X0 [H#K] BHELATICHED £,

Spotlight DF&SI{FFZF T ICTBICIF :

1 Apple A =2 —M5 [YZFLBERE] ZEIRL. [Spotlighl Z7 Vv 7 LE T,

2 [Spotlight] Y+ Y FUD [FSANv—]1 2T =27 Vv I LET,

3 RIATOREIMFIEH QICE, RIATDOTAAVETFAT by THhHY A MNERT Y T LET,
F=F4F « RSLTDIv—F VUV IEBRICTS

=T 4 X« RIATONRT =XV A%\ LEEIEZICE, Yr—F VI E2EMLET,
Jy—=FUVIRBAICTBICIE :

177V r—vav] | [2—F4VF7«] 74 NVE—DhH b [T A2A—T4VF4]1 77
Vr—varvei#HlEd,

2[(F4 A= 4V7 4] U4 Y RUOEDOWICHZ R a—LEFNLET,
3V — U= [Yv—FLasEpm ZRILET,
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Pro Tools[c3UTWindows YAFLZRBILT S

Pro Tools TIRHD /R T 4+ —< YV AZ{GOENZ LT ZICE, FTaAVEa—2—DREEITVET,

AV a—Z—%FET B0, ProToolsHA Y A= )VF 27 hHY Y McEHELLTRT AV
LTWEZeEHERLTL IV, HHEHEMERICOWTH LI, Windows DFiHEFZ ZSKL 2
T,

Windows 0¥ 27 LRGED R L HED T ¥ 2 — X —1c T 5 HHIC DV T,
AvidDY = 7% A b (www.avid.com) ZTELZE W,

WADRBE(L

Pro Tools DILFRRE ) &2 e KIC§ % 7=biT. Pro Tools N— Ko =7 &YV 7 Y 7 Z T Hiic
LUFOBEZITVET,

A Windows 0> 27 LT LS, AV a—2—EHEHLET,

A—Y— - PHUY MRIEZEBRADICT S

d—Y— . 7AhD U Nl (UAC) ZEHNICTSICIT :

1 [25—K > [OvbO-L/RIV] ZRRLET,

2 [1—Y— 7HIY NEREDRHDRLFRTE] 27V v 7 LET,

3[A-Y—T7HOVYN ZI7 Vv I LET,

4 [1—Y— 7hov MIEREOEE] 27w I LET,

5 X744 —7% [BAIULEW ICRELET,

6[OKI ZZ7VUv 2/ LET,

YRFL + AFVIA LREEEERET S

Pro Tools Zflif1 94 % & ZiX, Windows D [ AT L AXVINA] BFRFEE U] ICRET S0

ENHOET, ThT, YVATLOBRENA 7ICHRBZLREZEVLI—FT o7 - NZAE I
TLANY T« ISADEILEH ST EMNTEET,
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Windows OEFREEZEETBICIE :

1 [25—K> [AvbO—LARL] ZRIRLET,

2 [YRFLEEFaAUFA] Z0 VW I LET,
3EmREATVaV] BV UV ILET,

4 BEBMOTSVERRLET] OKMEZ7 )y 7 LET,
5 [@NT+—<VR] ZHRINL LT,

6 [JSVEEDZEE] 7V vy 7 LET,

7 BB ERREOZEE] 27V v I LET,

8 [BUA T ar] ZA707 T, I\—RF«R]> [ROBEHEER/\—R T« RoDOBEEYD] &%
RLUET,

9 E DATvarvesIVv s LET,

10 (B&E] (59) 74—V RZEBLL, 32V Ea—X—0DF—R— KD Backspace Z A, iz R
ZJB—)L LT [F7IELEL] IKRELET,

MoK Z27 Vv I LET, N—FT 4 RATDOREN EL] LD O, [BFA S av] X470
THHLET,

12 (75 VREDRE] V0V FUT, [ZBORE 27V v I LTy Y FYZHALET,

A ProTools BRIT 3 & BB (ERT 4 —% R ORRBEICD HDDET,
Pro Tools Z#& 735 &, TNETEIREINTVWBRBREICKL £ (RENVAZIHE).
> C. Pro Tools lICF U CEBERELZRE(LT Z L& TENRT+— VA ICORHKE
LT 7EEw,

HREINTLSRELL

Pro Tools &, AV a—X—ICA VA= ILENFMDY T -T2 T7RN—FT 7 « FIANN—D
WEEZIZTEHIDOET, RER/NNT A -V AZRZEDICE UTFEBTITHLET (TR,

o RExT 115 L% Pro Tools & [AIBFICHEEEN LR,

« Windows Messenger ® 1 L Y A~ Ny 77T RTHFTEY T b 2T - 1—F«
VT4 &4 TICT %,

« Pro Tools Dffi il 1E A% USB 78541 A%k 71T %,
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FEEDRE(L

AT LT Ko TE LUTD Y AT LR kic & - T Pro Tools DMREE/ WM Ld 22 &H D £9,
CHHADOY AT L EOMO T 055 LOKENENC A OK FLED T 2560 H2DT, Th
5SOREILIEBERIBECOIMMTITLEBITHLET,

JOotyY—« RA5Ja1—-UVIERBTD

I0tyY— A5 Ja1=UVIDINT#—=IJVAERBITBICIE :
1[3avEa—%-1 #E7) vy 7L, [FONF«] ZFEINLET,

2 [VAFLOFERE] 27V v I LET,

3T A—=RVR] 7 varo @BEl RExVEIVY I LET,

QT A—=RVAFTTary] U4V R0 BEEEl 2727V v 7 LET,

570y YDAV a—)V]¥rarDFDINyvsISOYRY—ERI ATV a VEBRLET,
60Kl ZZUw o LT [NNT4—VAATvav] v RuZHALET,

70K Z7Uy 7 LT [YAFLOTa)NT 4] U4 RUZHALET,
YATLDAY— Py IJIRBEEMETS

AV a—Z—THATNZ2HEANDENIEE ProTools ICEFI DU THENZ VY —ANELI KD ET,
CPUZMHETHARERRAZ— 7 v THHEEA 7ICY) OB A Z e TEXT,

fzZ U UFDOHBIZDWTIEMODEESHETT,

« R=Z TN AF4T7DYIT ) F U= (A¥—--Tusryay - F—Z2HALTVS

—HERDT TV = g VITHE)

« TITTURTLA Y=Y R

« fRVE-TY

o BEEY—E R
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VAT LDRAY— 7y IREZBNICITSICIS :

1[ZA&—=F] A=a—0 [TOaFSLDT 7 A)VEMHHE] I Mmsconfig] &% A7 AJIL. Enter
ELUCY AT LR AI—T 1+ VT« ZMEET,

22K XTDFD [RI—IPyTDFTYaVERR] ZERLET,

3 [R9—~7yTDEEEFHHAD] OF v 7 7ZIEd L, [OKl 27U I LET,

4 [BEH £V vy /LT, AVa—X—ZHEHLET,

5 Hitdd#hth, [YATLHEK] DAy =Y NERENET, [CORXRYvE—VEEZRLEV] T
¥ a3 VEEINT BRI, Pro Tools DIMEERES I M EL TV AW E I MERL T ZE W, WEEEES
LR R WEAE. Tmsconfig) ZFATL T, [RZ— 7 v TORIR] % [BEERS—KFPvT-FR
TOFIAR RSAN—EG—EREZFHAL] IR LET, £/, AX— 7y THHEAE RO A%
ARlcA 7O BEZ £T,

VATFLDINYIT Y TETS

VAT LDEEE Pro Tools DA YA M —IVH5E T LIS Ny I 7y Tead—7 40U T4 ZMHH L,
VAT RIATDARA=VRBEFELET, T LTHBFE, MENPRELLEAICE, VAT
L & Z DM DR E 2 RHICH L TEE T,
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R3%E Pro Tools R4

YO Avid 428609 Pro Tools®. 7% 45 B SC R4 4 W 40 {7 75 Mac 1 Windows 4t %2 %2 Fl 241
Pro Tools # . £ XML # Pro Tools & &t i 4l {5 B LL I Pro Tools R MIAEN e M5 E, S
{Pro Tools Z%#5H ) (it Pro Tools AY “ # B ” ZEHARML )

Pro Tools R ZA WUFPZEHR .

Pro Tools #x

B RGLAE Pro Tools %%, 5 Avid 003™ 5k Digi 002® 5 # #i#:11 . Eleven® Rack. Mbox®
5 Mbox 2 ZEE & i L8 M-Audio BEAFECA R . MEAb, i85 HI%S = J7 & B8 1119 Pro Tools
A, X BB TR AT T W] S H5 Y Core Audio ( Mac, f245 Mac HAEHL 1Y A &35 ) 5 ASIO (Windows)
LT

W EM Pro Tools HD %4

HBE (R INH A Pro Tools HD R4 {4k Pro Tools HD # 4, fit# 5 Avid HDX. Pro Tools|HD
5 HD Native BE{FECA (ol B0 i ) 28 G2 48 43 5 5 R Y 1/O TRk LA B AR 5 BT S pk . iC &
Avid HDX # Pro Tools|HD & i J ¥ Pro Tools HD #fF ik $ 8t 1 Fl 4 b B L B AU 5 A e
1% DSP.

# Complete Production Toolkit # Pro Tools HD ###5i Pro Tools

XL RS EH A Complete Production Toolkit #{F19 Pro Tools HD #fF5 Pro Tools #ff, fitf5
FEfTHEZS R Avid. Core Audio Z ASIO BE{FAL & H] .

Pro Tools Express ##

RS AUAT Pro Tools Express #fF, 5 Mbox ZIEFH ML N (H=40) B, (AKHMFL,

i (Pro Tools Express %445/ ) . )

Vi

\Q’ A XA Pro Tools REEMIE & Witk N A HAI, Uil www.avid.com/compatibility.
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RARRERSHE

Pro Tools REf% 5 2 IE R & B4k DAL AT, 7EZ0IER Windows 3 Mac H 3 HL Lizf7.

WAH A DVD s f A BEf ] Pro Tools 44 f ¥tk

Wi BRI M4 A BE T 4K Pro Tools Z#Ae )T .

Avid FRIE T3 g 0 R 1 B (AR, R AR AT DGk S B I 11 S A

Hi EARAR E R M R GLEOR FON AT T HRNL . SRR RS WERLRISE = Or e gk, IR
www.avid.com/compatibility

B8N iLok

FRER Pro Tools #AFELALEE— T2 AU iLok, LALZAT Pro Tools # A2 Hi. 4 Pro Tools Y& {1
AALATF— DR LAY iLok FI—AH T 424 Pro Tools MIE S, HANEE , S5 127 TUHY “ F4L
Pro Tools”.

A\ s Lok HEAFSHL 1WA USB #01. Pro Tools Az

MIDI &R

USB. FireWire #1 PCI MIDI #% 1 #] #£ Mac 5 Windows |5 Pro Tools R4 A 2. HA
Windows R4A L HH47 MIDI #:11,

A EARIBGCRR Y MIDI # DAl 4R 1951, i www.avid.com.

[2ied
N T AT AL B RO, TR Pro Tools R H— Dl Z A2l INERY B

i1 Apple & SE# fF4@ & M Disk Utility (# 4 T.H) /¥ (Mac) @ Windows # Disk
Management (##E ) (Windows) X &t 1T 01 4H 1K -
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BRARKRDBRE
AV RGBSR, AAHERE AT IR AT o 76 R GEUR B a5 5 FRR AT RE 23 0820 Bl Bkt
EORLR 8

\Q’ N T AR AEPERE , 0T RE B R LIRS #34 E  DigiBase TG SLIL G . A K

WAE R, 20 (Pro Tools %151 ) -

###1 Pro Tools
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A Pro Tools #AUA /& LU T321T Pro Tools HD ¥t . #2414 Pro Tools HD #2244 HDX
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A\ RIS . Pro Tools 44 Tk BUN A T L AT A4 Pro Tools. W%
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3EPAT U T HEZ —
o 1£ Mac #4 L FIf 3 Install Pro Tools.mpkg.
o 7E Windows R4t L HATA F#EZ —

« # Windows AutoRun (Windows H #1217 ) & F )i FARAS, D0 ifg_FoKe 2> th 3008 ) B 25
FEFE Install Pro Tools (%% Pro Tools ) LAJTIR%%s .

-

o WREEHT Windows AutoRun, H#FIFXGE Setup.exe, #AJ5iE+E Install Pro Tools (%%
Pro Tools ) LAIFF U4,

A 1€ Windows Z%4it, Wil User Account Control ( F k&l ) XHEHE, 4 5t Allow
(FeVF) o A2 RPN —LH 8, G521 Found New Hardware ( &2 BUBMH# 1)
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BeAh, R B S AR Y B A i i Windows  BUbR I B9 45 X IR HE, i i Continue
Anyway ({38R4k%E) .

L Evess ARON S
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o HEAAETA Pro Tools REHRFSUIAF G S MR P 50 (LAKCRIRINE ), i RIS BRI 3 L 5
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-
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8 41 B4 L H A B TR A
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Pro Tools ({¥i& T Mac) -

HitiEm
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o FTIFRGE DI EARFT TR
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¢ Pro Tools ¥ fF 44 | ARS8 )5 , BAE R A %19 Pro Tools R4, VAR TAEER
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ARRRIER
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A T BT S AL RS B Pro Tools #1 4, W 45 1 Mac - i« #0855 B JH B2 5 5048
Windows* il ififiz > AT -

# Mac R L Pro Tools

# Mac %4 L#% Pro Tools:

1 AR LU 5L B 3 5 5 L% T Pro Tools MK/ .

2 jln) Applications/Avid/Pro Tools/Pro Tools Utilities Jf ¥t Uninstall Pro Tools ( #1# Pro Tools ) o
3 #iili Continue (4k%:) AT .

4 B PR AT IR

REEH B SHIL Avid 75 HEE PITW RE R AT S RGO IR AR Avid B E B
WAEHE CS (F/3F) |, WA Safe Uninstall (Z4#HI# ).

Clean Uninstall (E£## ) #5176 Pro Tools XM, i REXH. Avid itk & MIDI
HOA WRITHHETIIG, BENTHREHITHEHRR, %6 Clean Uninstall (5242#1) .

5 i Uninstall (#12%) .
6 fil A BUE IR OK (HiE ) o
7 Hiid; Finish (SERL) DASCH] 2608 7 6 1,

# Windows R4 L%k Pro Tools

# Windows #4i EE# Pro Tools:

1 i£#% Start > Control Panel ( JF4f > Fathil itk ) .
2 #iif; Programs and Features ( F&tJ7 FIZhfE ) .
3 #iili Uninstall a program ( HI# 7 )

4 \NE %N U T 5 Fh %4 Avid Pro Toolso
5 i Uninstall (#12%) .

6 i BEHE UL RS R Pro Toolso

Q WHER, WA HIEIEIRCE (a0 Avid BCR ) ARATATE SR MIDI B # SRS T
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F P Pro Tools W3R S fEbERE, W /e i A HLE TR & o

FERE F AL AT, A0k LU FELR B 00 % 9t 322 4€ Pro Tools MK, 45¢ Mac OS X H A HEGUAL IR
AR B, 25 Apple OS X 34

A i 21fdiHl Mac OS X H 35y Software Update (AKFFEHr) ik, B MZIIAEnTBE & RETHE
i A 3573 Pro Tools T\H 1Y Mac OS WA, % Mac OS IAUERRAS B PEAH (5 B, 5ZS B A1 o
(www.avid.com) B ARAER S .

RARAER

KA EHThEE:

1 ) Apple S # ik $% System Preferences ( REETHE ) .

2 ¥k Software Update ( #XFHE#r ) -

3 Huidi Scheduled Check (FHHI#: 4 ) $EIIF

4 UK EHE Check for Updates (KA BT ) o

5 SE ML A )G . #E4F System Preferences > Quit System Preferences ( RAL Tl > B I RAEHWE ) o
RHATAEE

KA RERRThAE :

1 )\ Apple 3 #thik 4% System Preferences ( REETE ) o

2 ¥k Energy Saver ( TifiE#%) .

3 ¥ Computer Sleep (FHAFHLIEIR ) % # M Never (KA ).

4 % Display Sleep ( B /R#FHEMK ) % & %K Never (KA ).

5 Uil ¥4 Put the hard disk(s) to sleep when possible ( WISl fig, fili fifl 45 ik A BEAR ) 230

6 s¢ UL EEJG . ¥4 System Preferences > Quit System Preferences ( R4 Hi'E > B ili RA&HIE ) .
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Ji5E# Pro Tools fEALBESE, #ZI7E Apple System Preferences ( RETHE ) A5 s B4
BCpT A7 w2 /) Mac OS X EfLRE

EAR LN Pro Tools HEALRIERSIFR , H S (HALPHER T ) (Help > Keyboard Shortcuts
[FEB) > SR ]) .

RHANEHSEM Pro Tools MK Mac ##&i##E (Mac OS X Lion):
1 M\ Apple £ ik $% System Preferences ( RELTHE ) .

2 i Keyboard (##4#%)

3 Eﬁd} Keyboard Shortcuts ( ##iE ) #IF

A LAAS s BT 05 Pro Tools ##EHREEH#E b8 A9 Mac OS #EALIEE, TR AL W1
Mac HERLEE , LAY Mac ) RIS I E , EfTdEEHE Pro Tools fiH

o T Launchpad & Dock (Launchpad Dock) T
« Turn Dock Hiding On/Off (4T7F /M Dock Kz )
o T Mission Control (fE#54%il) T
» “Mission Control”
« Application windows (R HFEFE D)
« Show Desktop (<5t )
« Show Dashboard (%78 Dashboard)
« Mission Control > Move left a space ( Mission Control > i ZE#3—445[H] )
« Mission Control > Move right a space (Mission Control > A4 #3)— =[] )
« Mission Control > Switch to Desktop n ( Mission Control > VJ##t 2 1fi n )
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« T Keyboard & Text Input (HEEMCARKA) T
« Move focus to the window drawer (3l =% Ml )
o T Services (M%) F
« Send File To Bluetooth Device 3% %3 A B4 )
« Search With Google ({{i/i] Google #% )
« Spotlight
o Search Man Pages in Terminal (75255 T )
« T Spotlight T
. Show Spotlight search field ( #5 Spotlight # % FE)
« Show Spotlight window ({75 Spotlight %1 H )
o T Universal Access (i) T
o Zoom (&)
« Contrast (XfILEE)
« T Application Shortcuts (W HFFiREE) T
« Show Help menu (7R “#B)” 3H)
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HHANEHFEH Pro Tools MM Mac §2#&i#E (Mac OS X Snow Leopard):
1 M Apple S Hitii4% System Preferences ( RZETHE ) .
2 %3 Keyboard (###) o
3 #iifi Keyboard Shortcuts ( #E#HUAE ) I+ .
4 50T LIS SR B2 L5 Pro Tools 4 PR FEGE M8 (1) Mac OS #EALIEE . TR A4 4 b Wiy
Mac #4LH$E, Ef1HEEHE Pro Tools i1
« T Dashboard & Dock (Dashboard #l Dock) F
« Turn Dock Hiding On/Off (4T7F /& Dock Kz )
« Dashboard
« T Exposé and Spaces (Exposé 5 Spaces) T
o All windows (FrA#H )
« Application windows (/T 1)
o Desktop (i)
« T Keyboard & Text Input (fEMCAIA) T
« Move focus to the window drawer (B3I =6 H )
« 1 Spotlight T
« Show Spotlight search field ( 75 Spotlight # %5 B)
« Show Spotlight window ( 78 Spotlight % H )
« T Application Shortcuts (I R Fil$E) T
« Show Help menu (75 “#B)” 34 )
A Spotlight &5
Mac OS X Spotlight g2 F S LG G X AMEE & F 0 300 530 e TR 5] . REBGLT , i
Pro Tools #AEAR 232 Besm . Aad, W2RH - 7E s HUE R Pro Tools TR thafb AT I il s %
M7 Spotlight 7 i 72 th IF I X BE L #EAT R 51, W23 Pro Tools Z FitEAEE MUA R M, BT LUAE
[ Pro Tools #E47 KA E I H AT, XhiTA A MAESAEH] Spotlight R Jike.

A\ 550 spotlight %5125 Mac 0S X # Find (#4%) it
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1 )k Apple 35 h ik 4% System Preferences ( RATE ), Jf#idi Spotlight -
2 1£ Spotlight % H A, Hii Privacy (KAL) IR,

34 TR IEXSRE AT RG], R AR DS A e
ERSMERNBEDRE

T B AR AR Eh AR PR RE R H & RE .

BRAAEEE:

1330 F Applications/Utilities @ Disk Utility (@& T.H ) B HI#
2 A Disk Utility (BESLTH ) &1 10 A5 kP4 .

3 7E T HAZ P E+E Enable Journaling (i H &) o

i
bt

{A{tETF Pro Tools 8 Windows #4
AL Pro Tools W3R iR VERE , T ZEM AT Pro Tools B /4K A 5 % T X HLEATICH
PERC BT EHLZ AT, AR LA 0 B B SR B3 Pro Tools MK P o A S B BUAL KR A9 PRAH(S .,
% Windows 3C#4.

% Windows REe i & 1905 B ASREEHSHLIOEE, Vil Avid Wik (www.avid.com).

BEBEL
AR Pro Tools W3R 1ERE . THTEMH Pro Tools B {F FAR (1T X T 51 i B HEATHC B o

A\ 150 Windows RE B WE 2R . WL
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#* MM FPEG (UAC):

1 ¥ Start > Control Panel ( FF4fi > &R ) -

2 il User Accounts and Family Safety ( ik AR BEZR 42 ) o

3 il User Accounts (P ) o

4 i Change User Account Control settings (T2 JH ™ i Fr 458 i i ) o
5 J ¥ FF%  B] Never Notify ( /KASE SN )

6 il OK (%),

RERKFNNBREE

f#iJH Pro Tools i, Windows #J System Standby ( RZUFFHL) AL R4 AL E ) Always On
(—TIFAE ) o AT B T3 G FF PR 0 5 5 sl PR R e WERRR S e T 0 i sl A 1 . L
Windows I R4 B .

1 #£#% Start > Control Panel (i > $adil itk ) o

2 i System and Security ( REMEL) .

3 #1id; Power Options ( HLUEZE ) ,

4 3k LR Additional Plans (AT %) o

5 i High Performance (f#tEfE) .

6 #.ili Change plan settings ( B i E#H ).

7 %4 Change advanced power settings ( MR HIERE ),

8 7 Power Options ( HLUFEEED ) XIEHES, W78 Hard disk > Turn off hard disk after (f#f > 7
— B i) 5 G AR AL )

9 iy Setting (¥ ) wE¥i,

10 7£ Setting (Minutes) (B [4r8h] ) FBohk#e(E, JfF#% FitS L4l B Backspace (Z5A% )
SO ER 3 % Never (KA ) .

11 55 OK (®mE) . W&V EYCN Never (JKAR), i Power Options ( HLIIEDT ) Xf i HEHs bl
I SG A

12 7 Edit Plan Settings (#ifr &™) @, %k Save changes (PRFFEH) I CMIE 1.
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A\ Pro Tools e 5745 1 51515 High Performance (B5HERE ) HLIFHIE S 3418 Pro Tools .
Windows 5405 2 Wi B M BAE AR (WURI) . (K. fALFIT Pro Tools MR AL
i, NHEAE High Performance (#itEfE) ML .

- 4117714

Pro Tools LAl 8252 B TH3EAL I 22 iy HOAb AR A RE (4 SR Sh AR 3 s om o O 7 U e tE MR, ATl
(EIFARZR ) SR T 5t -

o 1E3E1T Pro Tools A Gis TR AR LB R
o RHISMTEIE GaTRRRE SRR, B0 Windows Messenger . H Ui i R L4 47 B2
o 7EiZ1T Pro Tools I C & F AR 21 USB e .

Lf10404

VLT R G (L1 7T AT B) T4 Pro Tools fEXSERSE LG TERE . A0 UAE 0 B A 5 i 2 )t
PEBRAE, OB ENTATAE 245 R S8 L AR e 69 Dy RE sO0s 37 A A F 2 i

AELEET R

AR TR R B AR -

1 #iii Computer (F&AYHLI ) JFiEH: Properties (J@1E) .

2 i Advanced system settings ( I RGKE ) .

3 7€ Performance (PERE) #4r, i Settings (& E ) #%4.

4 7t Performance Options (PEREMEW) @ Fth, Hif Advanced (##%) Ik,

5 7 Processor Scheduling (Zb¥E&it&l) #7>, B+ Background Services (JafiRk4) M.
6 #iifi OK (#fis ), XM Performance Options (PEREETT) 1.

7 Hif OK (#is€ ), XM System Properties ( RGEJEME) M.
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AL R P B>, ATk Pro Tools GBI Z . A5 SE7E 2 503 Sl 4 i i B 7 2 A
WE M FE CPU BEIR, Wl LLAF LR p e dsi
IR EEAS LT RS H /N O
o MEHEREGAT S (T8 DA B (g S 2 i AR T )
o BVH DT 55
I ERES
o BIHIEIRS

FARERHMA :

176 Start (JF4R ) 3 5109 Start Search (JFAR1% %R ) F#EA msconfig, JF#% T Enter PLFTJT System
Configuration Utility ( REAELHBRT ) .

2 7€ General (—fi%) #ETRT, %+ Selective Startup (A IEFEMIEE ) o

3 U EE Load Startup Items (& sh3i ) , A5 #d8 OK (#iE ) -

4 it Restart (FEHHZ) IHERIHTEL.

S5 EHiRsiZ)E, HHMLHS 2R System Configuration ( REACHE ) HE . WKL Don't show
this message again (AFR/RIIHE ) WA, HekA Pro Tools HITEREZ A FT e . W2k
TEREBA 6, 151817 msconfig, ¥ 1T A LAY Startup Selection (J5 )3 +% ) il )i % Normal Startup
- load all device drives and services (IE# 33 - NEHTA A& W RF RIS ) o s, Wbl
SEE A B H AR A PR

BB

BCE ARG LR Pro Tools Ji, TN 4 5E FRE e ok PRAF R GERE AL AU WA o ke, A 248 30 fi ] L,
SR AR S R SR S
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